Classroom JEOPARDY!

TEACHER’S GUIDE
Dear Educator,

Over the years, it's been a great pleasure to meet the hundreds of teachers who have appeared as contestants on our show. And we have always been especially delighted to hear how many of them have used the Jeopardy!® format to create their own games for use in the classroom.

What we've heard is that the same elements that have made Jeopardy! America’s Favorite Quiz Show® for nearly three decades have also made it a classroom favorite from elementary school through college. Over and over again, teachers have told us about how the Jeopardy! games they've developed with hours of hard work have created excitement, involvement, participation, and motivation—education the way it should be!

To them, and to all teachers seeking to challenge and motivate students, we’re proud to offer a new version of Classroom Jeopardy! that has been redesigned from the ground up for continued success in the classroom. It’s all here—“signaling in,” electronic scoreboards, the sound effects, Daily Doubles, even the famous Final Jeopardy! “Think Music.” But this Jeopardy! is designed to be tailored to your classroom curriculum and your students’ abilities.

With Classroom Jeopardy!, students can experience first-hand the sights, sounds and fast-paced excitement of the television show. More importantly, they’ll be totally involved in brushing up on knowledge and skills taken directly from your curriculum. It works right on your classroom TV, and because we designed it with busy educators in mind, it’s extremely easy to use.

We appreciate the dedication you bring to the immensely important job you do, and we’re proud that Classroom Jeopardy! can now be there to assist you. Thank you for all the gifts you give to your students, and best wishes for all that you, and they, will do in the future.

Sincerely,

Harry Friedman
Executive Producer
Jeopardy!®

PS: If you or any of your students are interested in trying out for the televised version of Jeopardy!, log on to www.jeopardy.com for information on contestant searches around the country.
# TABLE OF CONTENTS

## QUICKSTART GUIDE ............................. 6
- Set Up the Base Unit ....................... 6
- Battery Installation ....................... 7

## WHAT IS CLASSROOM JEOPARDY!? ......... 8

## COMPONENTS ................................. 9

## GETTING STARTED ............................ 10
- Get to Know the Basic Game Rules .......... 10
- Get to Know the Game Controls ............. 10
- Become Familiar with the Clue/Response Format ................. 10
- Choose a Preprogrammed Game ............. 10
- Consider How Strictly to Enforce Game Rules .......... 11
- Correct Responses ......................... 11
- Time Limits .................................. 11
- The Number of Responses Allowed per Clue .......... 11
- Introduce the Game Rules to the Class .......... 11

## STEP-BY-STEP THROUGH THE GAME .......... 12
- Getting Ready to Play: The Jeopardy! Start Menu ................. 12
- Registering Players ....................... 13
- Jeopardy! Gameplay ....................... 14
- Daily Double .................. 16
- Double Jeopardy! ......................... 17
- Moving to Double Jeopardy! from the End of Jeopardy! .......... 17
- Skipping to Double Jeopardy! without Completing Jeopardy! .......... 17
- Final Jeopardy! .................. 17
- Moving to Final Jeopardy! from the End of Double Jeopardy! .......... 17
- Moving to Final Jeopardy! from the End of Jeopardy! .......... 17
- Skipping to Final Jeopardy! During a Round ............. 18
- Final Jeopardy! Gameplay ............. 18

## CREATE YOUR OWN GAMES WITH CLASSROOM JEOPARDY! CLUE STUDIO 19
- Install Classroom Jeopardy! Clue Studio .......... 19
- Windows Installation ....................... 19
- Macintosh Installation ..................... 19
- Write a Game in Classroom Jeopardy! Clue Studio ............. 19
- Adding Video, Audio, and Images to Clues .......... 21
- Converting Videos to .avi Files Using FFmpeg .......... 22
- Inserting Symbols into Clues or Responses .......... 24
- Using the Math Clue Function ............. 25

## Store a Classroom Jeopardy! Game on a USB Flash Drive ..................... 27
## Opening and Resaving Classroom Jeopardy! Editor Files (.jgm Files) .......... 27

## HOT TIPS FOR HOSTS .......................... 28

## PLAYERS’ HANDOUT: GAME OVERVIEW .......... 29

## USING JEOPARDY! IN THE CLASSROOM 31
- Integrating Classroom Jeopardy! with Your Curriculum .......... 31
- Competitions .................. 31
- Family Events .................. 31
- Ways to Play That Get the Whole Class Involved ............. 32
- TV Style .................. 32
- Team Spirit .................. 32
- Pass the Remote .................. 32
- The Hot Seat .................... 32
- Student-Created Games ............. 32
- After School Tournament .......... 32

## STUDENT-CREATED GAMES ................. 33

## CREATING YOUR OWN GAMES ............... 34
- Planning the Game ............. 34
- Determining the Scope of Your Game ............. 34
- Defining the Important Knowledge and Concepts to Be Covered .......... 34
- Browsing Content Sources ............. 34
- Writing the Game ............. 34
- Developing Categories ............. 34
- Writing Clues and Responses ............. 35
- Clues Should Be Specific ............. 35
- Clues Should Elicit Straightforward Responses .......... 35
- Avoid Ambiguous Clues That Could Confuse Students .......... 36
- Creating Your Own Games ............. 36
- Clues and Point Values ............. 36

## SPECIAL OPTIONS IN THE GAME ............. 37
- The Jeopardy! Options Menu ............. 37
- Accessing the Options Menu Before Selecting a Game .......... 37
- Accessing the Options Menu After Selecting a Game .......... 37
- Accessing the Options Menu During a Game .......... 38
- Reviewing a Game .................. 38
- Checking Player Remotes ............. 39
- Adjusting Scores .................. 39
TABLE OF CONTENTS

CLASSROOM JEOPARDY! CLUE STUDIO .......................... 40
  Components ............................................. 40
  Guide Conventions ....................................... 40

INSTALLATION AND SETUP .................................... 41
  Windows Installation ...................................... 41
  Macintosh OS Installation ................................ 41
  Game Template Features .................................. 41

MENU BAR ..................................................... 42
  The File Menu ............................................. 42
  The Edit Menu ............................................ 42
  The View Menu .......................................... 43
  The Zoom Menu .......................................... 43
  The Round Menu ......................................... 43
  The Tools Menu ......................................... 43
  The Window Menu ....................................... 43
  The Help Menu ......................................... 43

TOOLBAR ..................................................... 43

TEMPLATE CELLS ............................................ 44
  Game Name Cell .......................................... 44
  Category Information Cells .............................. 45
  Clue/Response Cells .................................... 45
  Final Jeopardy! Cell ..................................... 45

GENERAL GAME CREATION INFORMATION ................. 45
  Filling Out a Game Template ............................ 45
  Editor Windows ......................................... 45
  Single-Play Clues ....................................... 46
  Moving Within the Template ............................ 46

ENTERING GAME CONTENT .................................... 47
  Entering Content for the Jeopardy! or Double Jeopardy! Round ........................................ 47
  Entering Content for the Final Jeopardy! Round .......................................................... 47
  Saving a Game ............................................ 47
  Printing a Game ......................................... 48
  Navigation Commands for Game Entry .................. 49
  Deleting Characters Within an Editor Window .... 49
  Cut/Copy/Paste Commands ............................... 49
  Select a Single Cell to Cut, Copy, or Paste ....... 49
  Select Multiple Cells to Cut, Copy, or Paste .... 50
  Classroom Jeopardy! Clue Studio ...................... 51
  Selection Memory ....................................... 51
  Shortcut Commands ...................................... 52

THE SPELL CHECKER ........................................... 52
  Spell Checker Feature .................................. 52
  Entire Game Spell Checking .............................. 52
  Interactive Spell Checker Operation .................. 53
  Classroom Jeopardy Online ............................. 53

IDEAS FOR CATEGORIES AND CLUES ......................... 54
  Classroom Rules and Procedures Games ............... 54
  Get Acquainted Games .................................. 54
  Spelling and Grammar Games ............................ 55
  Phonics Games .......................................... 56
  Vocabulary Games ....................................... 57
  High School Reading Games ............................. 58
  Arithmetic Facts Games .................................. 59
  Elementary Math Concepts Games ...................... 60
  Time-Telling Games ..................................... 61
  Geometry and Algebra Games ........................... 62
  Geography Games ....................................... 63
  History Games .......................................... 64
  Science and Health Games .............................. 65

TIPS FOR GAME EXTENSIONS .................................. 67
  Incorporate Other Media ............................... 67
  Add Some Action ........................................ 67
  Challenge Students to use Higher Thinking Skills .... 67

GAME ACCESSORIES .......................................... 68
  Accessories List ........................................ 68
  Accessory Scoreboards ................................ 68

SETTING UP THE ACCESSORY SCOREBOARD .................. 69
  Configuring Scoreboards ................................ 70
  Programming Player Remotes ........................... 71

TROUBLESHOOTING ........................................ 72

FCC INFORMATION ........................................... 73

WARRANTY INFORMATION ..................................... 73
This information is intended to give you a quick start using your Classroom Jeopardy! Unit and Classroom Jeopardy! Clue Studio software. However, it is not intended to replace the Teacher’s Guide. It will help you set up your Base Unit and start writing games. The Teacher’s Guide can be found on your Classroom Jeopardy! USB Flash Drive and includes far more detailed instructions and many tips on how to get the most from your investment in Classroom Jeopardy!. The most up-to-date information and applications can always be found on www.ClassroomJeopardy.com.

Set Up the Base Unit

1. Make sure your TV and the Classroom Jeopardy! Base Unit are both turned off. The On/Off switch is on the back of the Base Unit.

2. Notice the different colored connectors on the A/V cable. Plug one of the yellow connectors into the video jack on the Base Unit. Plug the white connector on the same end of the cable into the audio jack on the Base Unit.

3. Find the A/V (Audio/Video) input on your TV. Some have three jacks (VIDEO IN, AUDIO IN LEFT, and AUDIO IN RIGHT), but you will need to use only two. Plug the yellow connector on the free end of the cable into the VIDEO IN jack. Plug the white connector into the white AUDIO IN jack.

If your TV has more than one set of A/V input jacks, make sure you plug both connectors into the same set of jacks.
4. Insert three AAA batteries into the Host Remote and two AAA batteries into each Player Remote. See below for information on battery installation. (Batteries are not included with Classroom Jeopardy!)

**Note:** The battery screws have a wide slot so you can use a coin to unscrew them.

5. Plug the AC Power Adapter into the back of the Base Unit. Plug the other end of the AC Power Adapter into a power outlet.

6. Place the Base Unit on top of or near the TV.

8. Insert the USB Flash Drive into the back of the Base Unit.

9. Turn on the TV and the Base Unit.

10. Using the TV remote control or buttons on the TV, set the TV to VIDEO or LINE, and then view the various TV video line offerings until the Jeopardy! copyright/logo screen appears. You can turn off the TV and Base Unit until you are ready to start a game.

---

**Battery Installation**

- Do not use rechargeable batteries.
- Do not mix old and new batteries.
- Do not mix different types of batteries: alkaline, standard (carbon zinc), or rechargeable (nickel-cadmium) batteries.
- Do not recharge non-rechargeable batteries.
- Remove rechargeable batteries from the toy before recharging.
- Only charge rechargeable batteries under adult supervision.
- Only use batteries of the same or equivalent type as recommended.
- Insert batteries with the correct polarity.
- Remove exhausted batteries from the unit.
- Do not short circuit the supply terminals.
- To prevent corrosion and possible damage to the product, we recommend removing the batteries from the unit if it will not be used for more than two weeks.
WHAT IS CLASSROOM JEOPARDY!? 

CLUE: 

TRANSFORMS YOUR CLASSROOM INTO AN INTERACTIVE GAME SHOW, JUST LIKE THE ONE ON TV!

QUESTION: WHAT IS CLASSROOM JEOPARDY!? 

This exciting interactive game brings the sights and sounds of the television show Jeopardy! to your classroom. From the moment students hear the distinctive Jeopardy! theme music, they’ll be immersed in an entertaining multimedia experience. Developed in cooperation with the creators of the award-winning quiz show, Classroom Jeopardy! plays just like the television version with one important difference: The content is tailored by you, the educator, to align with your own curriculum.

When it comes to classroom use, most multimedia games are hit and miss: They might cover some of the concepts in your curriculum, but they may also include content your class hasn’t studied. The developers of Classroom Jeopardy! recognized this simple fact: You are the authority on what your students should know.

While Classroom Jeopardy! includes several preprogrammed sample games and other preprogrammed games are available separately, it’s easy to design custom games just for your students. Simply use Classroom Jeopardy! Clue Studio to input your own game content and then save to a USB Flash Drive. Plug the USB Flash Drive into the Classroom Jeopardy! Base Unit, then hook up the unit to a television or LCD projector. Your content will appear on screen, enhanced with sounds and visual effects!
A. **BASE UNIT** with plastic erasable name cards displays scores for three players or teams.

B. **PLAYER REMOTES** enable players to “signal in” when they’re ready to answer. The remotes are labeled 1, 2, and 3.

C. **A/V CABLE** connects the Base Unit to any television with standard audio/video cable jacks.

D. **AC POWER ADAPTER** connects the Base Unit to a power outlet.

E. **HOST REMOTE CONTROL** allows the game host to move through the game and identify responses as correct or incorrect.

F. **USB FLASH DRIVE** includes:
   - Classroom Jeopardy! Clue Studio software
   - Teacher’s Guide
   - Five preprogrammed game files
   - Reproducible players’ handout

G. **DRY-erase marker** is used to enter player or team names on the plastic erasable cards on the scoreboard. Markers are also used during Final Jeopardy! for writing down answers and wagers. (Teachers should have dry-erase markers available for each player.)

H. **ANSWER PADDLES** are two-sided write-on/wipe-off surfaces for wagers in Final Jeopardy!
GETTING STARTED

You’re probably eager to get started using Classroom Jeopardy! with your students. It is important that you and your students become familiar with the game before you actually play. Some advance preparation on your part will make the game a more effective teaching tool.

Get to Know the Basic Game Rules
The Players’ Handout on the USB Flash Drive was designed for students’ reference, but it serves as a good introduction for teachers, too. Start by reading through it to learn the basic Classroom Jeopardy! rules.

Get to Know the Game Controls
While the Classroom Jeopardy! interface is designed to be easy to use, it may take you some time to get used to the Host Remote Control that lets you move through the game. Your first game with students will go more smoothly if you practice on your own first.

Use the “Step-by-Step Through the Game” section of the Teacher’s Guide a few times to familiarize yourself with the flow of the game. Also refer to the section “Hot Tips for Hosts” in the Teacher’s Guide.

Although the remote control buttons work a bit differently in different areas of the game, this diagram explains their basic functions:

Become Familiar with the Clue/Response Format
Most game shows and trivia games follow a “question and answer” format. If you’ve ever watched the television game show Jeopardy!, however, you know that the game has a unique format. The host reads a clue and the contestants are asked to give a corresponding response. For example, most games might pose the question, “What is a baby cat called?” and players would answer, “a kitten.” In Jeopardy!, players would read the clue, “It’s a baby cat.” and respond with, “What is a kitten?” Glance at the sample games provided on the USB Flash Drive to get an idea of how clues and responses are worded.

Choose a Preprogrammed Game
Before you begin creating your own games, choose an appropriate preprogrammed game to play with your class. Each game consists of three rounds—Jeopardy!, Double Jeopardy!, and Final Jeopardy!

Remember that unlike the games you will create yourself, preprogrammed games may cover some topics your students aren’t familiar with. Choose a game that is easy enough that they will not feel frustrated. Playing a fairly simple game will help students master the game rules and format so they’ll be ready to take on more challenging curriculum-related games later.
Preprogrammed Games

<table>
<thead>
<tr>
<th>Game</th>
<th>Get Smart</th>
<th>Miscellaneous Mash Up</th>
<th>Jeopardy Jumble</th>
<th>Subject Scramble</th>
<th>Hodge Podge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difficulty</td>
<td>Easy</td>
<td>Easy–Medium</td>
<td>Medium</td>
<td>Medium–Hard</td>
<td>Medium–Hard</td>
</tr>
<tr>
<td>Categories</td>
<td>Our Solar System</td>
<td>Quake Quiz</td>
<td>Geography by Example</td>
<td>That’s an Order</td>
<td>Landmark Cities</td>
</tr>
<tr>
<td></td>
<td>Patriotic Places</td>
<td>Factor Facts</td>
<td>Namesakes</td>
<td>Sounds-alikes</td>
<td>Primary Colors</td>
</tr>
<tr>
<td></td>
<td>State Capitals</td>
<td>Fiction or Non-fiction?</td>
<td>The “Unch” Bunch</td>
<td>Important Documents</td>
<td>Circle Lingo</td>
</tr>
<tr>
<td></td>
<td>Double-duty Words</td>
<td>State of Emergency</td>
<td>Mighty Meals</td>
<td>Presidential Places</td>
<td>National Sports</td>
</tr>
<tr>
<td></td>
<td>What’s the System?</td>
<td>Cycles of Time</td>
<td>Insert a State</td>
<td>Ancient Writing</td>
<td>Super Stars</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>First Names</td>
</tr>
</tbody>
</table>

Consider How Strictly to Enforce Game Rules

Classroom Jeopardy!’s gameplay flexibility helps ensure that the game will be appropriate for different ages and skill levels. You, as the educator, are able to enforce rules and judge responses according to your own discretion.

Correct Responses

It’s up to you, as the host, to decide what qualifies as a correct response. You may, for example, choose to accept responses that are not worded in the form of a question, especially if you work with elementary-age students. Whatever approach you choose, be sure that you clarify your expectations to your students and are consistent in your enforcement.

Time Limits

Use your own judgment to determine how strictly to enforce the seven-second time limit, but be consistent. With younger students, in particular, you may decide to be lenient.

The Number of Responses Allowed per Clue

Classroom Jeopardy! has a special built-in feature that allows the other players to “signal in” with a response once an incorrect response has been given. (This is just how the television show Jeopardy! works.) Although a player who has responded incorrectly is not allowed to try the same clue again, you may choose to allow other players to answer it. In a three-player game, for example, if a player responds incorrectly, you may choose to move on to a new clue or to allow the other two players to signal in. If the second response is also incorrect, you may again choose to move on or allow the remaining player to signal in. If Accessory Scoreboards are used (see page 68), up to six players can get a chance to respond to a clue. In general, it’s best to have a consistent policy throughout the game, but you may need to make exceptions for some clues—for example, those that call for a true or false response.

In certain instances, you may want to give players only one opportunity to answer. For example, if a category consists of clues in which players identify a given statement as true or false, the player who responds incorrectly unwittingly gives away the correct response. To prevent players from getting an unfair advantage over the player who responds incorrectly, you have the option of making certain clues single-play when creating the game (see page 20). Single-play clues allow only one player to respond. If a player responds incorrectly, points are taken off that player’s score, and the game takes players back to the Classroom Jeopardy! game board where a new clue is chosen. You can choose to make some or all of the clues in a category single-play. For example, if all five clues in a category were true/false clues, you would probably want to assign the single-play feature to the entire category. If only Clue 1 were a true/false clue and the remaining clues multiple-play, then you would assign the single-play feature to just Clue 1.

Introduce the Game Rules to the Class

Classroom Jeopardy! is very fast-paced—there won’t be time to adequately explain the rules during a game. Avoid cries of “I didn’t know that rule!” and “That’s not fair!” by introducing the basic game rules before the students play. Reproduce the Players’ Handout, included as a separate file on the Jeopardy! USB Flash Drive, for students, and read through it as a class.
Start by gathering the materials needed to play. For the Final Jeopardy! round, each player will need an Answer Paddle and a Dry-Erase Marker. Players can use a pencil or pen and a sheet of paper.

Pass out the Player Remotes.

When the host presses the BEGIN button after reading a clue, a green timer bar will appear. This indicates that players have seven seconds to signal in. Players cannot signal in until the host presses BEGIN and the green bar appears. If players try to signal in before the bar appears, they will be blocked out of gameplay for a fraction of a second until they release and press the signal button again. Holding down the button for an extended period may cause a remote to malfunction.

Getting Ready to Play: The Jeopardy! Start Menu

1. Turn on the Base Unit and the TV. After two or three seconds, the legal information and Jeopardy! logo will appear on screen.

2. Press BEGIN on the Host Remote Control. You will see the JEOPARDY! START MENU with two options.

SELECT GAME: This lets you choose a game to play. If you choose SELECT GAME and move on to the next screen, but then decide you’d rather select OTHER OPTIONS instead, press BEGIN. You will return to the JEOPARDY! START MENU.

OTHER OPTIONS: This gives you two options at this point in the game. CONFIGURE SCOREBOARDS applies only if you have added one or more Accessory Scoreboards to the Base Unit. PROGRAM REMOTES allows you to reassign numbers or assign new numbers to Player Remotes.

3. Press the SELECT button to choose SELECT GAME. The first game title will appear. (The information at the bottom of the screen indicates how many games are available on the flash drive and which game in the series you are viewing.)
4. Use the arrow buttons to scroll through the games. Press the SELECT button when you see the game you want.

5. The JEOPARDY! START MENU will appear with four options.

START GAME: This moves you to the REGISTER PLAYERS screen.

CHANGE GAME: This lets you change to a different game. To do this, use the arrow buttons to highlight CHANGE GAME. Press SELECT. This returns you to the game selection screen, and you can choose a new game.

VIEW CATEGORIES: This lets you look at the categories for the game you have chosen. To do this, you will need to choose this option before selecting START GAME. To look at the categories, scroll to VIEW CATEGORIES, highlight it, and press SELECT. The categories will appear one at a time, with the round at the top and the category number at the bottom of the screen.

Use the down arrow or right arrow button on the Host Remote to scroll forward; use the up arrow or left arrow button to scroll backward. To exit the screen, press BEGIN. This will return you to the JEOPARDY! START MENU.

OTHER OPTIONS: This is similar to the choice in Step 2, but it includes a third option that lets you review the contents of a particular game.

Registering Players

6. Notice that the JEOPARDY! START MENU shows START GAME highlighted. Press SELECT, and the screen displays REGISTER PLAYERS.

HOT TIP! Have each player in turn press the button on his Player Remote. The corresponding score panel will light up displaying 00000, and an orange light will come on above the score display. Use the dry-erase marker to write the name of the player or team under the correct light.

You can also program the students’ or teams’ names into the remotes. After a student presses the button to register his remote, press the INCORRECT button on the Host Remote. The “P” in “Player” on the TV screen will blink. Press the INCORRECT button again and the letters on the screen will disappear. Using the alphabet on the Host Remote texting buttons, text in the player’s or team’s name. When you are done, press SELECT. Repeat with all players’ remotes.
When all the players are registered, press **BEGIN**. The Jeopardy! logo will appear, and the scoreboard will display 0 for each player’s score. The program will also randomly select a player to choose the first category and clue. That player’s signal light will light up orange on their scoreboard and their remote. You are now ready to begin play.

**Jeopardy! Gameplay**

1. To play Jeopardy!, press **BEGIN**. You will hear the Jeopardy! theme song and the voice of TV show announcer, Johnny Gilbert proclaim, “This is Jeopardy!”

2. The game board will appear and the clue values will fill in. Then you will hear Alex Trebek announce, “Here are today’s Jeopardy! categories,” and see the first category name on screen.

3. **HOT TIP!** Read the category name aloud, along with any corresponding explanation. To reveal the category explanation, hold the **CORRECT** button down while pressing **SELECT**. To move to the next category, press **SELECT** only.

4. Press **SELECT**. Read the next category and explanation aloud. Repeat until all the categories and explanations have been read.

5. Press **SELECT**. The game board will appear with the category titles filled in.

6. Ask the player whose signal light is lit to choose a category and value (for example, “School Time for 800”).

7. Use the arrow buttons to scroll to the category and value the player requested. When you see them highlighted, press **SELECT**.

8. Read the clue that appears on screen aloud. Press **BEGIN**.

9. A green timer bar will appear. This indicates that players have seven seconds to signal in.

**Important!**

Players cannot signal in until you press **BEGIN** and the green bar appears. If a player tries to signal in before the bar appears, she will be blocked out of gameplay for a fraction of a second until she releases and presses her signal button again.
10. If no player signals in within seven seconds:

No player will appear at the top of the screen. The screen will automatically return to the game board (or press BEGIN for the same result). The player who selected the previous category gets to choose again.

If one or more players signal in:

When the first player signals in, her signal light will turn green. Others who signal in after her will see their lights turn red. A red timer bar will appear. Say the name of the first player to prompt her—she has seven seconds to respond. Go to Step 11.

11. If the player responds correctly within seven seconds:

Press Correct on the Host Remote. The word Correct will appear at the bottom of the screen. Go to Step 13. (Note: The Host has the right to waive the seven-second rule. This may be especially appropriate for younger players. Simply let a player respond even after the red timer bar has run out. Gameplay will not be affected.)

If the player does not respond correctly within seven seconds:

Press Incorrect on the Host Remote. The word Incorrect will appear on screen. Go to Step 12 and scores will update.

12. To give other players a chance to respond:

Press BEGIN. The green timer bar will reappear. Players will again have seven seconds to signal in. The program goes to Step 10.

To move on to a new clue without giving the other players a chance to respond:

Notify players that they should not signal in. Press BEGIN, and let the green timer bar expire. Press BEGIN to return to the game board.

Important!

Classroom Jeopardy! allows up to 6 responses per clue—up to 3 with the basic Jeopardy! unit and up to 6 if additional scoreboards are used. A player who gives an incorrect response cannot signal in again until a new clue is given.
In certain instances, you may want to give players only one opportunity to answer. For example, if a category consists of clues in which players identify a given statement as true or false, the player who responds incorrectly unwittingly gives away the correct response. To prevent players from getting an unfair advantage over the player who responds incorrectly, you have the option of making certain clues single-play when creating the game (see page 20). Single-play clues allow only one player to respond. If a player responds incorrectly, points are taken off that player’s score, and the game takes players back to the Classroom Jeopardy! game board where a new clue is chosen.

13. Press **BEGIN** to return to the game board. Players’ scores will be updated.

14. Continue playing by returning to Step 6. The player with the correct response chooses the next category and value. If no player had a correct response, then the player who selected the previous category gets to choose again. (An orange light on the scoreboard will indicate the player whose turn it is to choose.)

### Daily Double

The Jeopardy! round has one Daily Double clue and the Double Jeopardy! round has two Daily Double clues. These clues are randomly selected by the program. The Daily Double clue allows only the player who just chose the category and point value to respond. See the Players’ Handout for rules concerning Daily Double. If you wish to help a player or team that is falling behind, you can **prompt** a Daily Double. The Host can assign the Daily Double to the currently picked clue by pressing and holding **INCORRECT** before pressing the **SELECT** button.

1. When a category and value that the program has randomly chosen to be the Daily Double has been selected, the **DAILY DOUBLE** logo will appear.

2. After the logo appears, a wager box is displayed.

3. Ask the player who selected the category and value to state his wager. (The Players’ Handout explains the maximum wagers allowed.)

4. Enter the wager amount using the Host Remote. Use the up arrow or down arrow button to change any of the five digits. Use the left arrow or right arrow button to move to a digit to the left or right. When the right amount is shown, press **SELECT**. You can also text in the wager using the texting buttons. Press the **INCORRECT** button on the Teacher Remote and use the texting buttons to text the wager. Press **SELECT** when you are finished.

5. Read the clue aloud, then press **BEGIN**. (The player will not need to signal in.)

6. If the player responds correctly within seven seconds: Press the **CORRECT** button on the Host Remote. The word **CORRECT** will appear at the bottom of the screen.

   If the player does not respond correctly within seven seconds:

   Press the **INCORRECT** button on the Host Remote. The word **INCORRECT** will appear at the bottom of the screen.

7. Press **BEGIN** to return to the game board.
Double Jeopardy!
Double Jeopardy! plays just like a round of Jeopardy! except that the point values are twice as high. Refer to the Players’ Handout for rules concerning the game. You can access Double Jeopardy! in one of two ways—either at the end of a Jeopardy! game or at any time during a Jeopardy! round.

Moving to Double Jeopardy! from the End of Jeopardy!
1. After the Jeopardy! round is ended, the TV screen will automatically display the Double Jeopardy! logo.
2. Press BEGIN. You will hear Alex Trebek announce, “And now Double Jeopardy!”
3. The game board will appear and the clue values will fill in. Then you will hear Alex Trebek announce, “Today’s Double Jeopardy! categories are” and see the first category name appear.
4. Proceed as you would with Jeopardy!

Skipping to Double Jeopardy! without Completing Jeopardy!
You can skip to Double Jeopardy! at any time during a round of Jeopardy!.
1. From the game board screen, press and hold BEGIN for three or four seconds until the JEOPARDY! OPTIONS MENU appears.
2. Use the arrow buttons to highlight START DOUBLE JEOPARDY!. Press SELECT. The current Jeopardy! game ends and Double Jeopardy! begins.

Final Jeopardy!
Final Jeopardy! is the last round of play. It consists of one clue. Refer to the Players’ Handout for rules concerning the game. You can access Final Jeopardy! in three ways:

Moving to Final Jeopardy! from the End of Double Jeopardy!
1. When the Double Jeopardy! round is ended, the TV screen will automatically display the Final Jeopardy! logo.
2. Press BEGIN to start.
3. Go to Step 1 of Final Jeopardy! Gameplay.

Moving to Final Jeopardy! from the End of Jeopardy!
When the Jeopardy! round is ended, you can skip Double Jeopardy! and move to the Final Jeopardy! round.
1. At the end of Jeopardy!, the Double Jeopardy! logo appears.
2. Press and hold BEGIN for three or four seconds until the JEOPARDY! OPTIONS MENU appears. Use the arrow buttons to highlight START FINAL JEOPARDY! and press SELECT.
3. Go to Step 1 of Final Jeopardy! Gameplay.
Skipping to Final Jeopardy! During a Round
You can skip to Final Jeopardy! at any time during a round.

1. Press and hold BEGIN for three or four seconds until the JEOPARDY! OPTIONS MENU appears.
2. Use the arrow buttons to highlight START FINAL JEOPARDY!. Press SELECT. The current Jeopardy! game will end, and Final Jeopardy! will begin. Go to Step 1 of Final Jeopardy! Gameplay.

Final Jeopardy! Gameplay
1. Once the Final Jeopardy! logo has appeared and you’ve pressed BEGIN, you will hear Alex Trebek say, “And now, here we go with Final Jeopardy!.”
2. After a pause, you will hear Alex say, “Today’s Final Jeopardy! category is.” The category name will appear on screen, along with instructions about making wagers. Read the category aloud.
3. Ask each player to write down his wager on the Answer Paddle or a sheet of paper. (See the Players’ Handout for the maximum wagers allowed.)
5. Press BEGIN. The Final Jeopardy! theme song will play. Players have until the end of the music (about 30 seconds) to finish writing their responses on their paddles or papers.
6. The number of the player with the lowest score will appear on screen. Ask that player to show her written response. Press CORRECT or INCORRECT. Then press BEGIN.
7. HOT TIP! The wager box will appear. Ask the player to show her written wager amount. Use the arrow buttons to enter the amount in the wager box on screen. Press SELECT. You can also text in the wager using the texting buttons. Press the INCORRECT button on the Teacher Remote and use the texting buttons to text the wager. Press SELECT when you are finished.
8. Repeat Steps 6–7 until all responses have been checked and wagers have been entered.
9. The program will automatically calculate the scores and display the number of the winning player. The grand introduction theme song will play, and you will hear Alex Trebek announce, “Today’s Jeopardy! winner is!” Read the name of the winner aloud.
10. Press BEGIN. The screen will return to the JEOPARDY! START MENU.
CREATE YOUR OWN GAMES WITH CLASSROOM JEOPARDY! CLUE STUDIO

Install Classroom Jeopardy! Clue Studio

Windows® Installation
Installing and Launching with Windows XP or Windows 7

1. Insert the Classroom Jeopardy! USB Flash Drive into a USB port on your computer.
2. The AUTO PLAY window will open. Select OPEN FOLDER TO VIEW FILES. If the AUTO PLAY window does not open, go to MY COMPUTER, and select CLUE STUDIO (removable drive).
3. Create a folder named “Clue Studio” where you want to store the Clue Studio software and the games you create.
4. Drag the Clue Studio application file CLUE STUDIO.JAR from the USB Flash Drive to your newly created Clue Studio folder.
5. Double-click CLUE STUDIO.JAR to open Clue Studio.

Macintosh Installation
Installing and Launching on a Macintosh with OS X

1. Insert the Classroom Jeopardy! USB Flash Drive into a USB port on your computer.
2. The USB Flash Drive icon will appear on your desktop. Double-click the icon to open Clue Studio.
3. Create a folder named “Clue Studio” where you want to store the Clue Studio software and the games you create.
4. Drag the Clue Studio application file CLUE STUDIO.JAR from the USB Flash Drive to your newly created Clue Studio folder.
5. Double-click CLUE STUDIO.JAR and to open Clue Studio.

Write a Game in Classroom Jeopardy! Clue Studio

1. Double-click the GAME NAME CELL.

The GAME NAME CELL editor window will appear.

Note: The editor windows will stop entering characters when they have reached maximum length.

Type in a name for your game. This is the name that will be listed on the game selection screen when you start playing Classroom Jeopardy!. When you are finished, click the OK button.
2. Double-click the Category 1 CATEGORY NAME CELL.

The CATEGORY NAME CELL editor window will appear. Type entries for the FULL SIZE CATEGORY field, the ABBREVIATED CATEGORY field, and the EXPLANATION field. The ABBREVIATED CATEGORY field will be displayed on your television when the game is played.

Open and complete all of the remaining CATEGORY NAME cells for SINGLE JEOPARDY!

3. Double-click the Clue 1 CLUE/RESPONSE cell.

The CLUE/RESPONSE cell editor window will appear. Type entries for the CLUE field and for the RESPONSE field. If applicable, select one of the SINGLE-PLAY CLUE OPTIONS. Single-play clues are clues that, when they are answered incorrectly, give away the correct answer to the other players. A True or False clue would be an example of a single-play clue.

Open and complete all the remaining CLUE/RESPONSE CELLS for SINGLE JEOPARDY!

4. Select ROUND—DOUBLE from the MENU BAR or click the Double J! tool on the TOOLBAR to select the DOUBLE JEOPARDY! page of the game template. Open and complete the CATEGORY NAME CELLS and the CLUE/RESPONSE CELLS on the Double Jeopardy! round page of the game template.
5. Double-click the **FINAL JEOPARDY! CELL**. The **FINAL JEOPARDY! CELL** appears on both the **SINGLE JEOPARDY!** and **DOUBLE JEOPARDY!** template pages.

The **FINAL JEOPARDY! CELL** editor window will appear. Type entries for the **CATEGORY** field, the **CLUE** field, and the **RESPONSE** field. When you have completed all the game template cells, you are ready to store the game onto a Classroom Jeopardy! USB Flash Drive, after which you can play your newly written game.

---

**Adding Video, Audio, and Images to Clues**

With Clue Studio, you can add video, audio, and images to clues as well. When the clue is selected, the image, audio, or video will play, followed by a text clue screen as normal.

For example, to enhance the clue “He was an influential leader of the American Civil Rights Movement,” you could add a picture of Martin Luther King Jr., a video of Dr. King leading the Montgomery Bus Boycott in 1955, or an audio clip from his “I Have a Dream” speech.

Image clues can also be used to display charts, graphs, special math equations, or any other visual clue.

Gather the images, audio clips, and video files you plan to use. Place them together in a folder, or on your desktop, to make it easy to find them when you are ready to insert them into the game.

Image files must be in .jpg format. Audio files must be longer than 0.2 seconds and in .wmv format. Videos must be in .avi format. Converting videos to .avi format suitable for Classroom Jeopardy! games is explained in the next section.

Press the **BROWSE** button at the bottom of the **CLUE/RESPONSE** editor window. Navigate to your image (.jpg), audio (.wmv) or video (.avi) file and select it. Click **OPEN** and the file will be inserted into that clue. Press **PREVIEW** to see how it will look in the game.
Converting Videos to .avi Files Using FFmpeg

In order to use video in Classroom Jeopardy!, you will need to convert your video clips to .avi format using a file converter named FFmpeg. You can download this conversion tool for free at the following Web sites:

**Macintosh version:** http://ffmpegx.en.softonic.com/mac

**Windows® version:** http://www.videohelp.com/tools/ffmpeg

**HOT TIP!** The most current Web addresses for FFmpeg converters can always be found at www.classroomjeopardy.com.

Download the FFmpeg converter to your computer and place it in the Clue Studio folder that contains the Clue Studio application (ClueStudio.jar). Placing the Clue Studio application and converter application in the same folder will enable the **CONVERT VIDEO** button to work properly.

1. Click the **SETTINGS** button. The **SETTINGS** window will open.

2. Click the **BROWSE** button next to the **FFmpeg PATH** line. Navigate to the **FFmpeg** application in your Clue Studio folder. Select the **FFmpeg** application and click **OPEN**. This will link the **VIDEO CONVERSION UTILITY** to the **FFmpeg** application.

3. Now click the **BROWSE** button next to the **OUTPUT DIRECTORy** line. This is where your converted videos will be placed. Navigate to the folder in which you will keep your converted videos and click **OPEN**. When you are ready to add your converted videos to your game, you will navigate to this folder from the **BROWSE** button in the Clue/Response window.

4. Please note that the video quality setting is also located in the **SETTINGS** window. When you begin to convert video you may return here to adjust this setting.

Before you begin converting video, you will need to initialize your settings.
To convert videos for use in Classroom Jeopardy:

1. Click the **CONVERT VIDEO** button on the toolbar. The **VIDEO CONVERSION UTILITY** window will open.

2. Click the **ADD** button and navigate to the video file you wish to convert. Click **OPEN** and the file will appear in the **SOURCE FILES** window. Add as many different videos as you need. The **VIDEO CONVERSION UTILITY** can convert an entire batch at one time.

3. Click the **SETTINGS** button to set the video quality. High quality will generate the clearest video, but the largest file. Low quality will generate video with less detail, but smaller file size. The video quality setting will apply to the entire batch being converted.

4. Click the **ENCODE** button to begin conversion. If you have not set the FFmpeg path, a dialog box will pop up and direct you to the **SETTINGS** window. (See the previous section regarding initializing settings.) When completed, the files will appear in the **CONVERTED FILES** window.
Inserting Symbols into Clues or Responses
The following symbols are available to use in categories, clues, and responses.

To insert a symbol, press the **SYMBOLS** button, to reveal the special characters. Select the symbol on the chart and click **INSERT**.

A letter like Ü, with an ascender, will overlap a letter like Ç, with a descender, if the character with the ascender lines up under the character with a descender. Adding an extra space in one of the lines of text will shift one of the characters over and fix the problem.
Using the Math Clue Function

Classroom Jeopardy! Clue Studio has the ability to create special characters for math clues. There are a few codes to learn, and then you can create math clues for your Classroom Jeopardy! games.

<table>
<thead>
<tr>
<th>Math Function</th>
<th>Tag</th>
<th>Type This</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Superscript</td>
<td>^</td>
<td>X^,2</td>
<td>X^2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X^,(1+2)</td>
<td>X^{(1+2)}</td>
</tr>
<tr>
<td></td>
<td></td>
<td>H^,(+), OH^,(-)</td>
<td>H^{(+)}, OH^{(-)}</td>
</tr>
<tr>
<td>Subscript</td>
<td>_</td>
<td>H,_2,O</td>
<td>H_2,O</td>
</tr>
<tr>
<td>Fraction</td>
<td>/</td>
<td>10/12 = ?</td>
<td>\frac{10}{12} = ?</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(10+X)/(12+Y)</td>
<td>\frac{10+X}{12+Y}</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(10+A/12)</td>
<td>\frac{10+A}{12}</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 (1/2) + 3 (1/2) = 8</td>
<td>\frac{4}{2} ,+ ,\frac{3}{2} = 8</td>
</tr>
<tr>
<td>Square Root (symbols menu)</td>
<td>√</td>
<td>√36</td>
<td>√36</td>
</tr>
<tr>
<td></td>
<td></td>
<td>√(3+6)</td>
<td>√(3+6)</td>
</tr>
<tr>
<td>Negative Number (hyphen)</td>
<td>-</td>
<td>-3 \times -4 = 12</td>
<td>-3 \times -4 = 12</td>
</tr>
<tr>
<td>Vertical Equations</td>
<td>VERT</td>
<td>VERT 3+16=19</td>
<td>3 ,+ ,16 ,\overline{19}</td>
</tr>
</tbody>
</table>
1. To create a math clue, double-click the CLUE/RESPONSE cell you will use for that clue. The CLUE/RESPONSE cell editor window will appear:

2. Type the math clue into the clue window using the math clue tags.

3. Click the MATH CLUE button. The Math Clue function will create a .jpg image of your clue. Every time you make a change to your math clue tags, remember to click the MATH CLUE button again, to refresh your image. You can check your math clue at any time by clicking the PREVIEW button.

4. Click the OK button to return to the Clue Response window and OK again to return to the Clue Studio game screen.

Note: If you are unable to create your math equation using the Math Clue tool, you can scan your equation and include it in your clue as an image.

The MATH CLUE button serves two functions. It creates the image of your math clue based on your math clue tags, and it also places the math clue in that cell of the game screen. If you change your math clue tags or move that clue to another cell or category, you will need to click the MATH CLUE button again to be sure the clue works correctly in the game.
**Store a Classroom Jeopardy! Game on a USB Flash Drive**

Now that you’ve finished filling in a game template, save the file to your Clue Studio folder. Name the file something that will make it easy to identify which game it is. Clue Studio will also create a folder of media assets using that same game name. Now you’re ready to copy the contents to a USB Flash Drive. Most USB Flash Drives can be used with Classroom Jeopardy!

**For Windows® Users:**
Insert the Classroom Jeopardy! USB Flash Drive into a USB port on your computer. The AUTO PLAY window will open. Select OPEN FOLDER TO VIEW FILES. If the AUTO PLAY window does not open, go to MY COMPUTER, and select CLUE STUDIO (removable drive). Drag both the game and the folder of game media assets (same name as the game) to the CLASSROOM JEOPARDY! USB FLASH DRIVE window. The game will not play correctly without the media assets folder.

**For Mac Users:**
Insert the Classroom Jeopardy! USB Flash Drive into a USB port on your computer. The USB Flash Drive icon will appear on your desktop. Double-click the icon to open Clue Studio. Drag both the game and the folder of game media assets (same name as the game) to the CLASSROOM JEOPARDY! USB FLASH DRIVE window. The game will not play correctly without the media assets folder.

Be sure to eject the USB Flash Drive before you remove it from the USB port. To eject the drive: Windows users, right-click the USB Flash Drive icon on your computer and select EJECT. Mac users, drag the USB Flash Drive icon to the trash.

Remove the USB Flash Drive and insert it into the back of the Classroom Jeopardy! Base Unit. Now you are ready to play!

---

**Opening and Resaving Classroom Jeopardy! Editor Files (.jgm Files)**

You can open the old versions of Classroom Jeopardy! games that you have on your computer using the new Clue Studio software. Simply open Clue Studio, click FILE and select OPEN. Navigate to the file and select it.

If you need to move games off an old-style cartridge, you will need to use the J-Link and the old J-Edit software. Follow these steps:

1. Plug the cartridge into the J-Link and plug the J-Link cartridge reader into the USB port of your computer.
2. Open the old J-Edit software
3. Click the cartridge icon in the toolbar. This opens the game cartridge interface. It shows the contents of the game cartridge.
4. Click one title and then click “load selected game into J-Edit.”
5. Click “save-as” and put the game in your Clue Studio folder (or wherever you store your games).
6. You can open the game with Clue Studio, edit, and save (or save as).

---

The flash drive included with Classroom Jeopardy! will hold approximately 512 MB. Classroom Jeopardy! games without images, audio or video are about 60 KB. Adding the media makes a big difference in size. You can fit 500 games with no media, 60 games with an average amount of media or about 10 games that are media rich with each having 10 or more large videos.
HOT TIPS FOR HOSTS

A host’s role includes making sure that Classroom Jeopardy! moves along smoothly. Here are some tips that will help make you a pro at running the game.

- **Instruct Players About the Green Bar.** At the beginning, make sure the players understand the importance of the green bar and how it affects their signaling in.

- **Choosing SELECT or BEGIN.** Can’t remember which button to press? Try one of them. In all parts of the game, only one of the two buttons is active. If you press the wrong one, nothing will happen and you’ll know you should press the other one.

- **Moving Around the Game Board.** To get from the first column to the last one, you can press the right arrow five times. It’s quicker, though, to press the left arrow once. Similarly, you can quickly scroll from the top row to the bottom row by pressing the up arrow once.

- **Referring to Clues and Responses.** Jeopardy! presents clues—not questions—for players to respond to. Referring to the material presented on the game board as clues and asking for correct responses will help to alleviate confusion over the “answer and question” format.

- **Entering CORRECT or INCORRECT.** If you press CORRECT when you intended to press INCORRECT (or vice versa), you can change your selection by pressing the desired button before you press BEGIN, and if you press BEGIN, you can still correct scores. If you make an error, you can adjust the score manually. (See page 39.)

- **Entering Wagers.** During Final Jeopardy! or when a Daily Double clue appears, you’ll need to enter wager amounts. If you make a mistake entering an amount, press INCORRECT before you press SELECT. The wager box will automatically reset to 0. You can then re-enter the amount.

- **Extending the Seven-Second Limit and Increasing Maximum Wagers.** Want to give players more time to respond or allow more than the maximum wager amounts? You may do both without affecting gameplay.

- **Skipping Rounds.** If you are short of time, you can skip to Double Jeopardy! or Final Jeopardy! at any point in the game. From the game board, just press and hold BEGIN for about four seconds to access a menu of options. (See page 38.)

- **Completing a Game on a Different Day.** You can play Jeopardy! one day and then continue with Double Jeopardy! the next day. However, to skip over the Jeopardy! round on the second day, you will need to first enter the round and then press and hold BEGIN for about four seconds. That will access a menu of options that will let you move to Double Jeopardy!. But the program will not save the scores if you shut off the unit. To keep the scores intact without leaving the unit on all night, you will need to write the scores on a sheet of paper. When your class gets back to playing the game, you can re-enter the scores before beginning the Double Jeopardy! round. (See page 39 for information on adjusting scores.)

- **Including Extra Players for Final Jeopardy!** If Accessory Scoreboards are used, up to six players with the top positive scores are chosen automatically by the program for the final round. If several players are tied, however, and more than six qualify for the round, the program still selects only six. You can include extra players by writing their wagers and adjusting the scores manually.
What’s Classroom Jeopardy!?
Classroom Jeopardy! is based on the television game show Jeopardy!. It’s a version of Jeopardy! made especially for classrooms.

How does it work?
The TV screen will display a game board with categories and point values. A player picks a category and value, such as “U.S. Presidents for 600.” A clue will appear on screen, and the host (usually the teacher) will read it aloud. The first player to “signal in” with the right response wins points. The player with the most points at the end of the game wins.

Who gets to pick the category and clue?
For the first clue of the game, the program randomly picks a player to choose the category and value. After that, the privilege is earned by a correct response. When it’s your turn to pick a category and value, there will be an orange light above your name on the scoreboard.

How do players signal in?
Each player will get a Player Remote. When you press the button, it sends a signal showing that you’re ready to respond to the clue.

How can you tell who signaled in first?
A green light will appear on the scoreboard above the name of the player who signaled in first. Other players who signaled in will have red lights above their names.

How long do players have to signal in and respond?
After the host reads the clue, a green timer bar will appear at the bottom of the screen. This means players have seven seconds to press their buttons. Once a player has signaled in, the bar will change from green to red. The player who signaled in first will have seven seconds to respond.

What do the numbers on the game board mean?
The numbers on the game board show the points you will win or lose depending on your response. For example, if you signal in for a clue worth 800 points and respond correctly, you will get 800 points. If you signal in and respond incorrectly, you will lose 800 points. A clue’s point value depends on how hard it is. A clue that is worth 200 points will be easier than a clue worth 600 points.

Do players lose points if they don’t signal in for a clue?
No. If you do not signal in, your score won’t change. This means that if you do not know the correct response, it is much smarter NOT to signal in than to signal in and take a wild guess.

Can players guess again after an incorrect response?
If you signal in and respond incorrectly, the other players will get a chance to signal in and respond, but you will not be able to guess again until the next clue appears.
**What’s the difference between Jeopardy!, Double Jeopardy!, and Final Jeopardy!?**

A game has three rounds: Jeopardy!, Double Jeopardy!, and Final Jeopardy!.

- In Jeopardy! (the first round), correct responses are worth 200 to 1,000 points.
- In Double Jeopardy! (the second round), correct responses are worth 400 to 2,000 points. (You may play some short games that do not have a Double Jeopardy! round.)
- Final Jeopardy! (the last round) has just one clue.

**What’s a Daily Double?**

Each Jeopardy! round has one Daily Double clue and each Double Jeopardy! round has two Daily Double clues. These clues are picked at random by the program. The player who chose the category and value is the only player in a Daily Double. Before hearing the clue, the player makes a wager—the number of points he is willing to bet on the clue. The maximum wager allowed depends on the player’s score and the round.

- In Jeopardy!, if the player’s score is less than 1,000, the maximum wager is 1,000. If the player’s score is 1,000 or more, the maximum wager is his entire score.
- In Double Jeopardy!, if the player’s score is less than 2,000, the maximum wager is 2,000. If the player’s score is 2,000 or more, the maximum wager is his entire score.

The host reads the clue aloud and the player has seven seconds to respond. If the player responds correctly, he wins the number of points in the wager. If he responds incorrectly, he loses the number of points in the wager.

**How does Final Jeopardy! work?**

Only players with points qualify for Final Jeopardy!. Players who have no points or negative points cannot play. Because it is possible to purchase extra Player Remotes and scoreboards, some Classroom Jeopardy! games may have more than three players, but only the top six with points at the end will qualify for Final Jeopardy!.

The Final Jeopardy! category is read aloud, and each player writes down how much he or she will wager. The maximum wager a player may make is his entire score; the minimum wager is 0. Again, the wager is the number of points the player will win if his response is correct or lose if his response is incorrect. The host then reads the clue, and players have about 30 seconds to write down a response. When the Final Jeopardy! theme music finishes, players show their responses and their wagers.
Classroom Jeopardy! is a great way to reinforce curriculum during class time. It also is a valuable educational tool in other situations as well. Here are some ideas for using Classroom Jeopardy! with students.

**Integrating Classroom Jeopardy! with Your Curriculum**

- Finish a unit of study with a game that reinforces what students have learned.
- Create a game for students to play at the beginning of the school year to review skills and knowledge that may be “rusty” after the long break.
- Play a game every Friday afternoon based on what you’ve studied that week.
- In the weeks leading up to standardized tests, use Classroom Jeopardy! as a fun way to review concepts students are likely to be tested on.
- Finish each semester with a “semester in review” game.
- Play Jeopardy! on rainy days during recess or lunch.
- Break students into teams and assign each to create a Jeopardy! game based on something the class is studying. Depending on their capabilities, allow them to act as hosts as the other students play their game.
- List six categories (for a Jeopardy! game) or 12 categories (for a game with both Jeopardy! and Double Jeopardy! rounds) on the board, and ask each student to write two or three appropriate clues. Create a game using their clues.

This is one of the most powerful ways to use Classroom Jeopardy!. In order to write good clues, students really must thoroughly review the material you have taught. When they host the game, they will also be the judges of whether responses given by their classmates are correct or not. The requirement to be good judges as well as hosts is a powerful motivation to learn and understand the material for which they are writing clues.

**Competitions**

Classroom Jeopardy! stimulates friendly competition and motivates students to learn. Competitions can be between teams or individuals, and they can involve one or more classes.

- Tournaments
- School-Wide Competitions
- Games Between Classes
- District-Wide Competitions

**Family Events**

Classroom Jeopardy! is a great way to showcase students’ abilities at school events where families are in attendance. Or get parents acquainted with school or classroom procedures by challenging them to a round of Classroom Jeopardy!.

- Back-to-School Night
- PTA Meetings
- Open House
- Science Fair
Ways to Play That Get the Whole Class Involved

Like the television show, Classroom Jeopardy! is set up for three players. One way to involve more students is to buy additional wireless remotes and scoreboards. Your game can be set up to accommodate up to 30 players! Another option is to just buy more wireless remotes and set them to function for players one through three. This provides a form of team play. (See the section “Game Accessories.”) However, you don’t need extra equipment to make the game worthwhile and fun for your students. As millions of TV viewers can attest, one can learn a lot just by watching the game. There are plenty of fun ways to play Jeopardy! in a classroom of 30 or more students.

TV Style

Have three students play while the rest of the class acts as the “studio audience.” The next time you play, you can either choose three new contestants or have the returning champion—the winner of the first game—take on two new challengers.

Team Spirit

Divide your class into three Jeopardy! teams to be used every time you play. For each game, have a different team member play while the rest of the members cheer them on. You might want to encourage team spirit by allowing students to choose a team name, mascot, and colors.

Pass the Remote

Divide the class into three teams, and choose a player on each team to begin. After each response, the remote is passed to the next player on the team.

The Hot Seat

Divide the class into three teams, and choose a player on each team to begin. If a player gets a correct response, he gets a chance to signal in on the next item. Otherwise, he passes the remote to the next player on his team.

Student-Created Games

 Invite individual students or groups of students to write their own Jeopardy! games. Give students printed gameplay templates to write categories, clues, and answers. This class-time or homework project is a great way to reinforce content from class. Once they have completed their games, you will have to input the games using Classroom Jeopardy! Clue Studio. If you have a computer students can use, have them input the game themselves. (See page 47.)

After School Tournament

Classroom Jeopardy! is a perfect after school activity for students who can stay. You will be surprised by the enthusiasm friendly competition can inspire. Try allowing students to sign up for a weekly game. A format in which the winner of the previous game takes on new challengers can be especially motivating. Students will be eager for a chance to unseat the returning champion!
As mentioned earlier, one of the most powerful ways to use Classroom Jeopardy! is to have individual students or groups of students write their own Jeopardy! games. The reason this activity is so effective is that the process of researching the content needed to write good clues requires students to thoroughly review the material you have taught. When the student or group hosts the game, they will also act as judges of whether responses given by their classmates are correct or not. The requirement to be good judges as well as hosts is a strong motivation to learn and understand the material covered by the game they write.

The following are a few suggestions about how you can organize this activity.

- Make the activity either a class-time or homework project.
- Provide each student or team with a copy of a blank Classroom Jeopardy! Clue Studio game template. (Open a new game in Clue Studio, and print it.) If you have a classroom computer that students are allowed to use, have the students type their clues directly into a game template in Classroom Jeopardy! Clue Studio. After they have completed and saved their game, you can load it onto a Classroom Jeopardy! USB Flash Drive.
- Define the content you want the students to cover. You may refer them to a chapter in one of their textbooks, to a syllabus for the class, or to some supplementary material you want to provide. It is important to remember, however, that the game should be reinforcing content that you have already taught. The game is not a substitute for sound instruction.
- Depending on your students’ ability level, you may want to provide the students with a copy of the “Creating Your Own Games” section that follows this one. It discusses how to write clues and responses.
- It is imperative that you review student games before they are played. Obviously you must check for accuracy, but check also for the mischievous clues students are often tempted to include. Depending on their content, you may decide to allow one or two for the fun they add to the game.
- When it’s time to play, let the team choose who will play the host and who will be the judges. Students should play host only if they have been trained to do so. An untrained host will cause unnecessary delays and confusion.
- Review with Classroom Jeopardy! is generally more effective if the teacher selects the players for the game. This ensures that everyone gets a chance to participate in the review of the content. It’s even more effective if you have multiple wireless player remotes allowing teams of players rather than individuals to compete. If you prefer, players’ names can also be “drawn from a hat” ensuring a random selection of players.
- As you watch the game being played, take the opportunity to make notes about which clues reveal a lack of knowledge or understanding. You can “debrief” the game immediately after it is over or perhaps you will want to wait until the next day. Classroom Jeopardy! is all about helping you know how well your students have learned the material you have taught.
Once you’re familiar with the basic game rules and format, you’re ready to take full advantage of Classroom Jeopardy! by creating games designed to reinforce your own curriculum.

Planning the Game
Before you begin writing clues, think about your instructional objectives and the kind of content you want to include.

Determining the Scope of Your Game
You may choose to create a game that covers a range of subject areas, a general topic broadly, or a narrow topic in depth. For example, you might write a game that covers the past month of instruction in reading, math, and science, develop a game based on fifth grade science concepts, or devote an entire game to the water cycle. Once you begin writing the game, you may find that you have too much or too little content and need to narrow or expand your focus. Don’t be afraid to modify your plan as you go.

Defining the Important Knowledge and Concepts to Be Covered
Jot down a list of the important concepts the game should cover. You can refer to this list as you begin writing clues.

Browsing Content Sources
You’ll probably find it helpful to look through some classroom materials for possible game content. Here are some good sources of ideas for categories and clues:

- Curriculum standards
- Student textbooks, especially glossaries and study guides
- Teacher’s guides, especially indexes
- Assignments your students have done in class or as homework
- Tests and quizzes your students have taken
- Recent lesson plans you’ve used
- Quiz games posted on the Internet by teachers (go to www.ClassroomJeopardy.com)

Writing the Game
Creating a Jeopardy! game involves developing categories, writing clues, listing correct responses, and assigning point values. To see how this information will be formatted, take a look at one of the games included on your Classroom Jeopardy! flash drive, but wait until you’ve fleshed out your game categories and clues to begin filling them out. Otherwise, you’ll do a lot of erasing as you modify clues and change point values.

Developing Categories
A full Jeopardy! game has 13 categories: six in the Jeopardy! round, six in the Double Jeopardy! round, and one for the Final Jeopardy! question. If that sounds overwhelming, you can create a shorter game. You might choose to have only four categories per round or include only the Jeopardy! round. It’s easy to modify a game once you’ve created it: You can add additional categories or a Double Jeopardy! round later if you like.

The first categories that come to mind as you develop your game may be straightforward, subject-based categories, such as “Explorers” or “Rulers.” While these categories work fine, creative categories can make the game more fun. If your class was studying explorers and rulers, you might include a category “C in History” in which correct responses were Columbus, Cleopatra, conquistador, Hernan Cortez, and Catherine the Great. Another possibility would be to include a category called “Namesakes” in which correct responses would all be places named after explorers or rulers: Hudson Bay (named after Henry Hudson); Victoria, British Columbia (named after Queen Victoria); Louisiana (named after King Louis XIV); Colombia (named after Columbus); and Seattle, Washington (named after Chief Seattle). For more category ideas, see pages 54–66.
Writing Clues and Responses

A full Jeopardy! game has five clues per category, but you can include fewer if you prefer a shorter game. As you’ve seen, Jeopardy! traditionally uses a “clue and response” format, rather than the “question and answer” format used by most games. If you want students to respond in the form of a question, be sure that your clues are worded so students can think of an appropriate question.

Clues Should Be Specific

A clue should include enough information to enable students to provide the response YOU had in mind. Here are clues that have been worded so that they contain enough information that the intended response is clear.

😊 Clue:  “THE YEAR OF THE U.S. BICENTENNIAL”
Response:  “WHAT IS 1976?”

😊 Clue:  “THIS FUTURE U.S. PRESIDENT DRAFTED THE DECLARATION OF INDEPENDENCE.”
Response:  “WHO IS THOMAS JEFFERSON?”

😊 Clue:  “TWO STATE CAPITALS NAMED AFTER U.S. PRESIDENTS”
Response:  “WHAT ARE LINCOLN, NEBRASKA AND JACKSON, MISSISSIPPI?”

Clues Should Elicit Straightforward Responses

Word your clues so that they lend themselves to simple, straightforward responses. Once students have the right concept in mind, you don’t want them to have to struggle to word their response as a question, as they might if you worded your clues like these examples:

😊 Clue:  “PLANTS TURN SUNLIGHT INTO FOOD.”
Response:  “WHAT HAPPENS DURING THE PROCESS OF PHOTOSYNTHESIS?”

😊 Clue:  “MIX RED AND YELLOW TOGETHER.”
Response:  “HOW DO YOU MAKE ORANGE?”

It’s best to word your clues so that students will word their responses with “What is” or “Who is.”

😊 Clue:  “THE PROCESS BY WHICH PLANTS TURN SUNLIGHT INTO FOOD”
Response:  “WHAT IS PHOTOSYNTHESIS?”

😊 Clue:  “MIXING RED AND YELLOW MAKES THIS COLOR.”
Response:  “WHAT IS ORANGE?”
Avoid Ambiguous Clues That Could Confuse Students

Here are some examples of clues that could confuse students and cause them to give responses that are completely off-target. In addition to the “correct” response, note the number of possible responses that are not what you were probably looking for.

宁县 Clue: “1976”
Alternate responses: “WHAT IS THE YEAR AFTER 1975?”
WHAT WAS THE YEAR OF THE MONTREAL OLYMPIC GAMES?”

宁县 Clue: “THOMAS JEFFERSON”
Desired response: “WHO DRAFTED THE DECLARATION OF INDEPENDENCE?”
Alternate responses: “WHO WAS THE THIRD U.S. PRESIDENT?”
WHO WAS JOHN ADAMS’ VICE PRESIDENT?”

Creating Your Own Games

宁县 Clue: “THEY’RE NAMED AFTER U.S. PRESIDENTS.”
Desired response: “WHAT ARE LINCOLN, NEBRASKA; JACKSON, MISSISSIPPI; JEFFERSON CITY, MISSOURI; AND MADISON, WISCONSIN?”
WHAT ARE THE GEORGE WASHINGTON BRIDGE AND THE LINCOLN TUNNEL?”

Clues and Point Values

As you write your clues, you will need to assign each clue a different point value. A category in a full Jeopardy! round has clues worth 200, 400, 600, 800, and 1,000 points, while a category in a full Double Jeopardy! round has clues worth 400, 800, 1,200, 1,600, and 2,000 points.

Keep in mind that the points assigned to a given clue should depend on its difficulty, not its importance. If you want to give an important concept plenty of weight in a game, try devoting more than one clue to it—different clues can address different aspects of the concept.
Classroom Jeopardy! allows you to perform several special functions before and during a game:

- Review the contents of a game
- Check the Player Remotes against the names on the scoreboard
- Adjust players’ scores
- Skip a round before or during a game
- Return to the Jeopardy! game board
- Exit a game
- Check that the scoreboards have been assigned the appropriate player numbers
- Assign or reassign numbers to Player Remotes

To perform these functions, you will need to access the Jeopardy! Options Menu. You can do this in several ways: before selecting a game, from the Jeopardy! Start Menu after selecting a game title, and at any time during gameplay.

**The Jeopardy! Options Menu**

**Accessing the Options Menu Before Selecting a Game**

1. When you first turn on the Base Unit and TV (see page 12), you will see the copyright and legal information displayed. Press BEGIN on the Host Remote. The Jeopardy! Start Menu will appear.
2. Scroll with the arrow buttons on the Host Remote and highlight OTHER OPTIONS.
3. Press SELECT. The Jeopardy! Options Menu will appear with two options.
4. Use the arrow buttons to highlight the desired option. Press SELECT.

(Note: Configure Scoreboards applies only if you have added one or more Accessory Scoreboards to the Base Unit. This option lets you check that the scoreboards have been assigned the appropriate player numbers, such as 4, 5, 6, or 7, 8, 9. Program Remotes applies only if you want to reassign new numbers to your Player Remotes or if you have purchased additional unprogrammed remote controls and need to assign numbers to them. See the section “Game Accessories” for information on configuring scoreboards and programming remotes.)

**Accessing the Options Menu After Selecting a Game**

1. When you select a game title and access the Jeopardy! Start Menu (see page 12), you will see four items offered.
2. Use the arrow buttons on the Host Remote to highlight OTHER OPTIONS. Press SELECT.
3. The Jeopardy! Options Menu will appear with three options.
4. Use the arrow buttons to highlight the desired option. Press SELECT.

(Refer to the section “Game Accessories” for information on configuring scoreboards and programming remotes. See page 38 for information on reviewing the contents of a game.)
Accessing the Options Menu During a Game
You can access the JEOPARDY! OPTIONS MENU at any time during a game.

1. Press and hold BEGIN on the Host Remote for about four seconds. The JEOPARDY! OPTIONS MENU will appear, displaying several options.

   RETURN TO GAME: This takes you back to the Jeopardy! game board. (However, if all the categories and values on the game board have been selected, you will advance to the next round.) The RETURN TO GAME option appears until you enter the Final Jeopardy! round.

   ADJUST SCORES: This lets you adjust players’ scores if, for example, you make a mistake in entering a wager during a Daily Double clue or a Final Jeopardy! round, if you incorrectly enter CORRECT or INCORRECT, or if you wish to allow extra players to participate in Final Jeopardy!. (See page 39 for information on adjusting scores.)

   START DOUBLE JEOPARDY!: This appears in Jeopardy! (the first round). When selected, Jeopardy! ends and Double Jeopardy! begins.

   START FINAL JEOPARDY!: This appears in Jeopardy! and Double Jeopardy! rounds. When selected, the current round ends and Final Jeopardy! begins.

   CHECK REMOTES: This lets you check that the Player remotes are operating properly. (See page 39 for information on checking Player remotes.)

   EXIT GAME: This takes you back to the JEOPARDY! START MENU.

2. Use the arrow buttons to highlight the desired option. Press SELECT.

   Note: If you access the JEOPARDY! OPTIONS MENU after a clue has been revealed but before a player has made a response, that clue and any associated point value will be lost. When you go back to the game board, you will see that the clue is no longer available.

Reviewing a Game
The JEOPARDY! OPTIONS MENU lets you review the contents of a game before you start the game. You can access this option only after you have selected a game title (see page 13).

1. When you select a game title and access the JEOPARDY! START MENU, four options will appear.

2. Use the arrow buttons on the Host Remote to highlight OTHER OPTIONS. Press SELECT.

3. The JEOPARDY! OPTIONS MENU will appear with three options. Use the arrow buttons to highlight REVIEW GAME. Press SELECT.

4. The content for the three rounds in the game will be presented one at a time on screen. The line at the bottom of the screen identifies the round (SJ for Single Jeopardy!, DJ for Double Jeopardy!, and FJ for Final Jeopardy!) and the category number (each round has six categories). The bottom line also identifies if the information displayed on screen is the abbreviated category name (CAT ABBR), the full category name (CAT NAME), or one of the clues (each category has five clues).

5. Use the right arrow or down arrow button to scroll forward through the content. Use the left arrow or up arrow button to move backward.

6. Press BEGIN to return to the JEOPARDY! OPTIONS MENU.

7. Press BEGIN again to return to the JEOPARDY! START MENU.

In this example, the bottom line indicates that “Colors” is the abbreviated category name for the first category in Single Jeopardy! (the first round). The abbreviated category name appears on the Jeopardy! game board.
Checking Player Remotes

When you access the **JEOPARDY! OPTIONS MENU** during a game (see page 12), you can check that the Player Remotes of your registered players are operating properly.

1. Use the arrow buttons to highlight **CHECK REMOTES**. Press **SELECT**.
2. All the scoreboard displays will become blank, and **CHECK REMOTES** will appear on screen.
3. Ask the players to press the buttons on their remotes. If the remotes are working, each score panel will show 00000 and the light above it will turn orange for two seconds.
4. Press **BEGIN** to return to the **JEOPARDY! OPTIONS MENU**. The players’ scores will be displayed on the scoreboard again.

Adjusting Scores

The **JEOPARDY! OPTIONS MENU** allows you to adjust players’ scores (for example, when you enter the wrong wager amount). The option **ADJUST SCORES** will appear whenever the menu is accessed and there is at least one score displayed on the scoreboard. (The scores of players who are disqualified after the Final Jeopardy! round starts cannot be adjusted once **BEGIN** is pressed after the Final Jeopardy! logo appears.)

1. Use the arrow buttons to highlight **ADJUST SCORES**. Press **SELECT**.
2. You will see **ADJUST SCORE FOR PLAYER** on screen, followed by the player number of the lowest numbered registered player. Use the up arrow or down arrow button to scroll through the list of numbered players. The corresponding scores will start to flash on the scoreboard. When the desired player number appears, press **SELECT**.
3. The current score of the selected player will appear on screen. Use the arrow buttons to adjust the score as required.
4. Press **SELECT**. This enters the adjusted score and returns to the **JEOPARDY! OPTIONS MENU**. Or, if you change your mind and decide you don’t want to adjust the score or discover that you’ve changed the wrong score, press **BEGIN**. The changes you made will then be voided.
Classroom Jeopardy! Clue Studio and the USB Flash Drive are a software/hardware combination that let you write Classroom Jeopardy! games on a Macintosh or Windows® computer and play them on Classroom Jeopardy!.

With Classroom Jeopardy! Clue Studio, you simply fill in a game template on your computer. Then you plug the Classroom Jeopardy! USB Flash Drive into the USB port of your computer and transfer the game content directly from your computer to the USB Flash Drive. The whole transfer takes only seconds!

The Classroom Jeopardy! Clue Studio software allows you to view each clue exactly as it will appear on your TV screen. Special commands have also been added to make the game writing process more convenient. For example, with the click of your mouse, you can copy and paste your entries—from single clues to whole categories to complete rounds! Classroom Jeopardy! Clue Studio even includes a handy Spell Checker function that lets you check the spelling of your game content quickly and easily.

With Classroom Jeopardy! Clue Studio, you can also easily open games created in earlier versions of Classroom Jeopardy! so they can be edited, copied, and saved in the same way as new games that you have created with Classroom Jeopardy! Clue Studio.

**Guide Conventions**

The following conventions are used in this guide:

The names of all interface elements (menus, buttons, window titles, dialog boxes, titles, etc.) are typeset in blue. For instance, “Click the **OK** button.” means the user should click the **OK** button in a dialog box.

**MENU OPTION** is used to indicate a menu choice. For instance, **FILE OPEN** means the user should click the **FILE** menu and select the **OPEN** option.

Whenever a combination of keys on the keyboard should be pressed simultaneously, they will be displayed in the following manner:

![Control Key](control.png) + ![O Key](o.png) means the user should press the **CONTROL** key and **O** keys at the same time. In this case the result would be the display of the **OPEN** dialog box.

Note that on most PC keyboards the **CONTROL** key is labeled **CTRL**. Macintosh users should use the **COMMAND** key instead of the **CONTROL** key in keystroke combinations.

---

**Windows®**

**System Requirements**

- Operating system: Microsoft® Windows® (Windows 7 / Windows XP)
- Processor: Pentium® 133 MHz (or higher)
- RAM: 128 MB (or higher) recommended; 64 MB minimum
- Disk space (min): 50 MB minimum free space on hard drive
- USB port: USB 1.1 or 2.0
- Display resolution: 1024 x 768 (or higher) recommended; 800 x 600 minimum
- Pointing device: Microsoft-compatible mouse or other pointing device

**Macintosh**

**System Requirements**

- Operating system: Macintosh OS X
- Processor: Power PC (G3 or higher recommended)
- RAM: 128 MB (or higher) recommended; 64 MB minimum
- Disk space (min): 50 MB minimum free space on hard drive
- USB port: USB 1.1 or 2.0
- Display resolution: 1024 x 768 (or higher) recommended; 800 x 600 minimum
- Pointing device: Apple mouse or other pointing device
INSTALLATION AND SETUP

Windows® Installation

Installing on a PC with Windows®
1. Insert the Classroom Jeopardy! flash drive into a USB port on your computer.
2. The AUTO PLAY window will open. Select OPEN FOLDER TO VIEW FILES.
3. Create a folder on your desktop or hard drive, called “Clue Studio.” (To do this, navigate to your C: drive and select it. Right-click in the window and select New → Folder. Name the folder “Clue Studio.”) This is where you will save all of the Classroom Jeopardy! game files you create.
4. Drag the Clue Studio application file “Clue Studio.jar” from the flash drive to your newly created Clue Studio folder.
5. Double-click the Clue Studio application and to open Clue Studio.

Congratulations! You have successfully installed Classroom Jeopardy! Clue Studio.

Macintosh OS Installation

Installing and Launching on a Macintosh with OS X
1. Insert the Classroom Jeopardy! flash drive into a USB port on your computer.
2. The flash drive icon will appear on your desktop. Double-click the icon to open Clue Studio.
3. Create a folder in your Applications folder, called “Clue Studio.” This is where you will save all of the Classroom Jeopardy! game files you create.
4. Drag the Clue Studio application file “Clue Studio.jar” from the flash drive to your newly created Clue Studio folder.
5. Double-click the Clue Studio application to open Clue Studio.

Congratulations! You have successfully installed Classroom Jeopardy! Clue Studio.

Game Template Features

When you start up Classroom Jeopardy! Clue Studio, the screen displays a blank game template. You’ll use the template to type in the content for your games. The template is set up so that you can view the content in either a Single Jeopardy! round or a Double Jeopardy! round but not both at the same time. The Game Name cell and the Final Jeopardy! cell, on the other hand, are always displayed at the top and bottom of both the Single Jeopardy! and Double Jeopardy! rounds.

If you already use popular applications like Microsoft Word®, AppleWorks, or Microsoft Excel®, you’ll find that Classroom Jeopardy! Clue Studio uses the same familiar commands and conventions.
The following pages outline the game template’s key features: the MENU BAR, TOOLBAR, STATUS BAR, and CELLS. The MENU BAR has nine main headings: FILE, EDIT, VIEW, ZOOM, ROUND, TOOLS, WINDOW, INSERT, and HELP. Each heading gives you access to various pop-up menus, commands, and options. The first item in the MENU BAR is the program icon. Its purpose is to provide you with a visual clue about what program is currently active.

**The File Menu**

- Select FILE—NEW or type control + N to open a blank template for creating a new game.

- Select FILE—OPEN or type control + O to display the OPEN dialog box. Select a game file then click the OPEN button to open the selected game.

- Select FILE—SAVE or type control + S to save the game you have just created.

- Select FILE—SAVE AS... To open the SAVE AS dialog box. Type the name under which you want to save the file then click the SAVE button to save the game.

- Select FILE—PRINT PREVIEW to see what the printed template will look like when you print it. The template will open in your browser. Select FILE—PRINT or type control + P to open the print dialog window.

- The FILE menu also displays a list of up to the 10 most recently opened Classroom Jeopardy! games. Select a game name listed in the FILE menu to open the game’s template for editing.

**The Edit Menu**

- Select EDIT—UNDO or type control + Z to undo the most recently completed action.

- Select EDIT—REDO or type control + Y to restore the most recently deleted action.

- Select EDIT—CUT or type control + X to delete the data from any single- or multiple-cell template selection or any selected text in any editor window and store a copy of it on the clipboard.

- Select EDIT—COPY or type control + C to copy the data from any single- or multiple-cell template selection or any selected text in any editor window and store a copy of it on the clipboard.

- Select EDIT—PASTE or type control + V to paste the cut or copied data currently on the clipboard into cells on the template or in an editor window as appropriate. (See page 49 for an explanation of how selection, cut, copy, and paste work in Classroom Jeopardy! Clue Studio.)
The View Menu
- Select VIEW→TOOLBAR to toggle the display of the toolbar at the top of the screen; deselecting this feature will hide it.
- Select VIEW→STATUS BAR to toggle the display of the STATUS BAR at the bottom of the screen; deselecting this feature will hide it. The STATUS BAR shows descriptions of menu items or TOOLBAR items as the mouse pointer is passed over them and displays the SPELL CHECKER progress bar when a spell check is under way.

The Zoom Menu
- Select any of the settings to select the template view’s magnification percentage: 50%, 75%, 100%, 125%, 150%, 175%, or 200%. Classroom Jeopardy! Clue Studio will then default to the selected ZOOM PERCENTAGE each time you run the program. The ZOOM PERCENTAGE won’t be changed until you choose a different setting.

The Tools Menu
- Select TOOLS→SPELL CHECKER to display a dialog box asking if you want to open the SPELL CHECKER and check the entire game. Click the YES button to begin checking the entire game. Click the NO button to dismiss the dialog box.

The Window Menu
- Select WINDOW→NEW WINDOW to open a duplicate of the front most window and add a number to the end of the file name displayed on the title bar designating which copy of the window you’re viewing. One reason you might want to do this is to SELECT, CUT, COPY, and PASTE clue cells from one window to the other in order to rearrange the clues for the Jeopardy! round of the game you are writing.
- Select WINDOW→CASCADE to reduce the size of all open windows and display them stacked down and to the right in the order they are listed in the WINDOW menu. Click the MAXIMIZE/ZOOM button on any window to return all the windows to their full size.
- Select WINDOW→TILE to resize all open windows and display them distributed as evenly as possible on your screen without overlapping. Click the MAXIMIZE/ZOOM button on any window to return all the windows to their full size.

The Round Menu
- Select ROUND→SINGLE to display the Single Jeopardy! round template. Select ROUND→DOUBLE to display the Double Jeopardy! round template.

The Help Menu
- HELP→ABOUT CLUE STUDIO will display a splash screen with the version number and copyright information for the Classroom Jeopardy! Clue Studio software.

The TOOLBAR is located under the MENU BAR. It allows you to access certain options that are also available in the MENU BAR. To choose an option, simply click the appropriate icon. (To see what an icon stands for, mouse over it; a short description will appear, indicating the purpose of the icon, and a longer description will appear in the STATUS BAR at the bottom of the screen.)

- Select the NEW tool to open a blank template for creating a new game.
- Select the OPEN tool to display the OPEN dialog box. Click on a game file name in the OPEN dialog box list of files to select it, then click the OPEN button to open the selected game.
Select **SAVE** to open the **SAVE** dialog box. Type the name under which you want to save the file, then click the **SAVE** button to save the game. The file will be saved with the suffix “.html”. An .html file generates a separate folder of pictures and other assets that must be in the same folder as the .html file for the game to work correctly. Classroom Jeopardy! Clue Studio game files must be created and edited with Classroom Jeopardy! Clue Studio to work correctly with the Classroom Jeopardy! Base Unit.

Select the **CUT** tool to cut (remove) template cell data or editor window text to the clipboard from which you can paste it into single- or multiple-cell template selections or a field in an editor window.

Select the **COPY** tool to copy (duplicate) template cell data or editor window text to the clipboard from which you can paste it into single- or multiple-cell template selections or a field in an editor window.

Select the **PASTE** tool to paste the current template cell data or editor window text on the clipboard into single- or multiple-cell template selections or a field in an editor window.

(For a discussion of the select, cut, copy, and paste features of Classroom Jeopardy! Clue Studio see page 49.)

Select **EDIT→UNDO** or type `control + Z` when you are in template view to undo the most recently completed action. **SELECT EDIT→REDO** or type `control + Y` when you are in template view to restore (redo) the action you have just undone using the **EDIT→UNDO** or `control + Z` command.

Select the **PRINT** tool to print the game that you are currently viewing on the computer. The template format of your game will open in your browser. Select **FILE→PRINT** or type `control + P` to open the print dialog window.

**SINGLE J!** **DOUBLE J!** Select either the **SINGLE J!** or **DOUBLE J!** tool to view either the **SINGLE JEOPARDY! (SJ)** or **DOUBLE JEOPARDY! (DJ)** round on the screen.

Select the **CONVERT MOVIE** tool to open the **VIDEO CONVERSION UTILITY** dialog box. When you have the **FFMPEG CONVERTER** correctly downloaded to your **CLUE STUDIO** folder, you can use this button to convert video to .avi format to view in Classroom Jeopardy!.

Select the **ZOOM ADJUST** tool to view a game template at different magnifications. The magnification percentage appears in the small window to the right of the bar. With the **ZOOM ADJUST** tool, you can view the game at varying magnifications instead of set increments.

Select the **ZOOM UP/DOWN** tool to also choose different magnification settings. Click on either the **UP** or the **DOWN** arrow. Each time you click, the degree of magnification will be displayed in the small window to the left of the tool.

---

**TEMPLATE CELLS**

The game template consists of four kinds of cells, each containing a particular type of information: game name, category information, clues/responses, and Final Jeopardy! content.

**Game Name Cell**

The cell for the game name appears at the top of the screen. When you load a game onto a Classroom Jeopardy! flash drive, the game name is used to arrange the contents of the flash drive in alphabetical and numerical order.
**Category Information Cells**

Each Jeopardy! round and Double Jeopardy! round is made up of six categories which are displayed in six columns. The top three cells of each column contain information about the category: the category name, the abbreviated name (the name as it appears on the Jeopardy! game board on your TV screen), and any explanation that will help clarify how the category is played (such as *Unscramble the animal names*).

**Clue/Response Cells**

Each of these cells displays a single clue and the corresponding response.

**Final Jeopardy! Cell**

This cell displays the Final Jeopardy! category, clue, and response.

---

**GENERAL GAME CREATION INFORMATION**

**Filling Out a Game Template**

Once you have an idea of what your categories and clues are going to be, you can begin typing them into the game template.

**Editor Windows**

When you start up Classroom Jeopardy! Clue Studio, the program opens to a blank game template displaying a Single Jeopardy! (SJ) round. To type in the game content, you must first select the cell in which you want to work and then bring up its corresponding editor window. There is an editor window for each of the four types of cells.

- Game name cell
- Category cell
- Clue/response cell
- Final Jeopardy! cell

You can access an editor window in one of three ways:

- Use the mouse to single-click inside the cell. The entire cell will turn orange. Then press `e` to display the editor window for the cell.
- Use the mouse to double-click inside the cell. Its editor window will appear on the screen.
- Use the ARROW keys to move through the template until you get to the desired cell, then press (See “Moving Within the Template” on page 46.)
Once you access the editor window for a cell, you can start typing. The window displays the text in the way it will appear on your TV, so you can see exactly how the content will look. The editor windows for all cells behave in the same way. The editor window is the only place where you can key in text. Once you finish typing the text, exit the editor window by clicking on the OK button or click the CANCEL button to close the window without saving your changes. You may also close an editor window by clicking on the EXIT/CLOSE box at the top right-hand corner of the window. Closing an editor window will return you to the game template view. If you later want to revise or delete the text in the cell, just return to its editor window in order to make your changes.

Edit text in editor windows as you would edit text in most programs. Use the backspace or delete key to delete characters, or use select, cut, copy, and paste. See page 51 for information about selecting entire cells in order to cut, copy, and paste them into other templates.

**Single-Play Clues**

Jeopardy! is designed so that if a player gives an incorrect response to a clue during a game, the other players still get a chance to respond to the same clue and win points. For example, in a three-player game, if Player 1 responds to a clue incorrectly, then Players 2 and 3 have an opportunity to respond to the clue.

However, in certain instances, this may not be desirable. For example, if a category consists of clues in which players identify a given statement as true or false, the player who responds incorrectly unwittingly gives away the correct response.

To prevent players from getting an unfair advantage over the player who responds incorrectly, Classroom Jeopardy! Clue Studio gives you the option of making certain clues single-play. Single-play clues allow only one player to respond. If a player responds incorrectly, points are taken off that player’s score, and the game takes players back to the Classroom Jeopardy! game board where a new clue is chosen. You can choose to make some or all of the clues in a category single-play. For example, if all five clues in a category were true/false clues, you would probably want to assign the single-play feature to the entire category. If only Clue 1 were a true/false clue and the remaining clues multi-play, then you would assign the single-play feature to just Clue 1.

To make clues single-play, simply click the single-play option either in the editor windows for the category information cells or in the editor windows for the individual clue/response cells. To change a clue back to normal from single-clue, simply deselect the single-play option by clicking on it. When a cell has been designated as single-play the upper left corner of the cell will display a black triangle.

**Moving Within the Template**

As you type in your game content, you can move from cell to cell or from round to round by pressing the following keys:

- **↓** Move down within a column.
- **↑** Move up within a column.
- **→** Move right from one cell to the next.
- **←** Move left from one cell to the next.

Navigation in each column or row is “looped” so that, if, for example, you are in the bottom cell of a column, pressing **↓** will move you to the top cell. If you are in the far right column (Category 6), pressing **→** will move you to the first column (Category 1).
**Entering Game Content**

**Entering Content for the Jeopardy! or Double Jeopardy! Round**

1. Access the editing window (see page 45) for the **GAME NAME** cell located at the top of the template. Do this by single-clicking in the cell and pressing enter, or use the mouse to double-click in the cell. Fill in the name of the game.

2. Access the editing window for the **FULL SIZE CATEGORY** name, the **ABBREVIATED CATEGORY** name, and the category **EXPLANATION** for any category. (One editor window is provided for all three cells.)

   Do this by single-clicking in the cell and then pressing enter, or by double-clicking in the cell. Then do the following:
   - a. Type the **FULL SIZE CATEGORY** name and the **ABBREVIATED CATEGORY** name. (The **ABBREVIATED CATEGORY** name appears on the full 30-cell Jeopardy! game board when it is displayed on your TV.)
   - b. **Optional:** Type an explanation that will clarify the kind of response that the category requires. For example, if each clue in a category is made up of scrambled animal names, the explanation might be “Identify the animal in each scrambled letter clue.” The explanation is displayed during the game by holding down the **CORRECT** button and pressing **SELECT** on the Host remote.
   - c. **Optional:** Click the **SINGLE-PLAY** option if you wish to make all clues in the category single-play. (See page 46 for an explanation of single-play clues.)
   - d. Click the **OK** button or on the **EXIT/CLOSE** box to exit the editor window and return to the game template.

3. Access the editor window for any clue. Type in the clue. You’ll see it exactly as it will appear on your TV screen. If you want to make the clue single-play, click the single-play option. Then click the **OK** button or click the **EXIT/CLOSE** box to exit the editor window and return to the template.

4. Move through the template by clicking in the individual cells or by using the keys described on page 46. Continue filling in the clues and category information for the round.

**Entering Content for the Final Jeopardy! Round**

The Final Jeopardy! content is displayed at the bottom of both the Single Jeopardy! and Double Jeopardy! templates. Typing the content in either the Single Jeopardy! or Double Jeopardy! round will automatically transfer the information to the other round. There is no need to type the Final Jeopardy! information twice.

1. Access the editing window for the **FINAL JEOPARDY! CELL** by clicking in the cell and pressing enter. Or, simply double-click in the cell.

2. Type in the category, clue, and response.

3. Click the **OK** button or click the **EXIT/CLOSE** box to exit the editor window and return to the game template.

**Saving a Game**

You can save your game at any time during your writing/editing process. To save a game, follow these steps.

1. Select **FILE→SAVE** on the menu bar, press control + shift, or click the tool on the toolbar.

   The **SPELL CHECK** dialog box will appear. Click **YES** to run spell check, **NO** to continue saving. A dialog box will appear if any cells are incomplete. Click **YES** to continue.

2. The **SAVE** dialog box will appear. Type the file name for your game.
3. Click the **SAVE** button.

Once saved, the file name will appear on the window’s title bar. It will also be included in the game list that appears in the **FILE** menu, however, the .html file suffix/extension will not be displayed in this list. Depending on the preferences you have set for your computer, the .html suffix/extension may or may not appear in **OPEN** or **SAVE** dialog boxes.

**Printing a Game**

You can print the game when you have finished filling in the template. To get an overview of the game, you can use a printed copy of the completed template as a guide.

1. Select **FILE→PRINT PREVIEW**. The template you are viewing will open in your default browser.

2. Select **FILE→PRINT** in your browser menu. Click **ALL** to print both pages of the template, or if you want to print only one page at a time, type in the selected page. Then click the **OK** button.

Click on a **ZOOM IN** or **ZOOM OUT** button or click anywhere on the screen with your mouse to magnify the viewing area. Press either the **NEXT PAGE** or **PREVIOUS PAGE** button at the top of the screen to go from the Single Jeopardy! round to the Double Jeopardy! round. Select **CLOSE** or click the window’s **EXIT/CLOSE** box to exit the print preview screen and return to the template.
Navigation Commands for Game Entry
To make the game entry process faster and easier, you can use a variety of keyboard shortcuts to move around in an editor window during game entry.

1. Positioning the Cursor in an Editor Window
   Move your cursor within any blue pane of an editor window using the HOME, END, and ARROW keys.
   - HOME moves the cursor to the beginning of a line within any blue pane of an editor window.
   - END moves the cursor to the end of a line within any blue pane of an editor window.
   - CONTROL + HOME moves the cursor to the beginning of the first line within any blue pane of an editor window.
   - CONTROL + END moves the cursor to the end of the last line within any blue pane of an editor window.
   - LEFT OR RIGHT moves the cursor to the left or right 1 character within any blue pane of an editor window.
   - UP OR DOWN moves the cursor up or down 1 line within any blue pane of an editor window.

2. Moving Within the Template
   Move within a game template by pressing the appropriate keys. See page 46 for a list of these keys.

Deleting Characters Within an Editor Window
Use BACKSPACE and DELETE to delete characters. Place the cursor behind the character(s) you want deleted, and then press BACKSPACE. Place the cursor in front of the character(s) you want deleted, and then press DELETE.

Or you can click and drag to highlight text and delete it by pressing the delete or BACKSPACE key.

Cut/Copy/Paste Commands
When you are in template view, you can cut or copy an individual cell, a group of cells, an entire category, or an entire round of one game, and then paste the text into the same game or into a different game.

Select a Single Cell to Cut, Copy, or Paste
Click on a single cell (game name, category, clue/response or Final Jeopardy!) to select it. It will be highlighted in orange. Orange highlighted single-cell selections or multiple-cell selections are referred to as the selection. The Single Jeopardy! view and the Double Jeopardy! view for the same game have separate and independent selections. Each separate game also has its own independent selections.

You may do the following with a single selected cell:

1. EDIT — Double-click the cell or press ENTER while it is selected. Its editor window will be opened.
2. COPY — While the cell is selected, click the tool on the toolbar, choose the EDIT→COPY option from the menu bar, or press CONTROL + C.
3. CUT — While the cell is selected, click the tool on the toolbar, choose the EDIT→CUT option from the menu bar, or press CONTROL + X.
4. PASTE — While the cell is selected, click the tool on the toolbar, choose the EDIT→PASTE option from the menu
5. A copied or cut single-cell selection can only be pasted into another compatible single cell.
   a. A GAME NAME cell can only be pasted into another GAME NAME cell.
   b. A CATEGORY INFORMATION cell can be pasted into any other CATEGORY INFORMATION cell.
   c. A CLUE/RESPONSE cell can be pasted into any other CLUE/RESPONSE cell.
   d. A FINAL JEOPARDY! cell can only be pasted into another FINAL JEOPARDY! cell.

You can change the selection in the following ways:

6. Once a single-cell selection has been made, you can move it within the category/clue/response grid by using the ARROW keys. (Note: When using the ARROW keys, the selected cell wraps around between the right and left edge columns, and the top and bottom edge rows of the template grid.)

7. Once a single-cell selection has been made, you can move between different cell types (GAME NAME, CATEGORY INFORMATION, or FINAL JEOPARDY!) within the template by using the Tab key. (Note: when using the Tab key, the selection moves in the following circular sequence: GAME NAME, CATEGORY 1, FINAL JEOPARDY!, GAME NAME,...) The selection will not enter the clue/response grid.

8. Once a single-cell selection has been made, you can move between template areas in the reverse direction using Shift + Tab. (Note: when using the Shift + Tab keys, the selection moves in the following circular sequence: FINAL JEOPARDY!, CATEGORY 1, GAME NAME, FINAL JEOPARDY!,...) The selection will not enter the clue/response grid.

9. Once a single-cell selection has been made, you can move from its cell editor window to an adjacent cell’s editor window using the control + ARROW keys ( for the cell above, for the cell below, for the cell to the left, and for the cell to the right). The cell editor window for the originally selected cell will close and the appropriate adjacent cell’s editor window will open. When using the control + ARROW keys, the selection wraps around between the right and left edge columns, and top and bottom edge rows.

Select Multiple Cells to Cut, Copy, or Paste

Click and drag on multiple cells to select them: Typically you will drag down and/or to the right to select more cells, and up and/or to the left to select fewer cells. Once the desired group of cells is selected, simply release the mouse button to finalize the selection. You can select a new group of cells by simply clicking a new starting cell and dragging to expand the selection. Remember, the Single Jeopardy! view and the Double Jeopardy! view for the same game have separate and independent selections. Also, each separate game has its own independent selection, which is remembered when you close and reopen the file.

If you begin making the selection in the GAME NAME cell, the “row/column” grid selection will always start in the first column and first row cell of the category/clue/response grid. This is because the top row, which is the CATEGORY INFORMATION row, has a special status relative to the other cells in its column.

You may modify an existing single- or multiple-cell selection using the shift + ARROW keys.

The Shift + keys will expand the current selection downward. The Shift + keys will expand the current selection to the right. The Shift + keys will reduce the current selection upward from bottom to top. The Shift + keys will reduce the current selection from right to left.
Classroom Jeopardy! Clue Studio

You may do the following with a multiple-cell selection:

1. COPY – While the cells are selected, click the tool on the toolbar, choose the EDIT→COPY option from the menu bar, or press 
   \[ \text{control} + c \].

2. CUT – While the cells are selected, click the tool on the toolbar, choose the EDIT→CUT option from the menu bar, or press 
   \[ \text{control} + x \].

3. PASTE – Highlight the destination cells, then click the tool on the toolbar, choose the EDIT→PASTE option from the menu bar, or press 
   \[ \text{control} + v \].

4. A copied or cut multiple-cell selection can only be pasted into another compatible multiple-cell selection.
   a. If the source selection starts with a GAME NAME cell, the destination selection must also start with a GAME NAME cell.
   b. If the source selection starts with a CATEGORY INFORMATION cell, the destination selection must also start with any other CATEGORY INFORMATION cell.
   c. If the source selection starts with a CLUE/RESPONSE cell, the destination selection must also start with any other CLUE/RESPONSE cell.
   d. The size and shape of the destination selection must match that of the source selection. For example, a CLUE/RESPONSE cell source selection consisting of 2 columns by 3 rows can be pasted into any destination selection of 2 columns by 3 rows of another CLUE/RESPONSE cell destination selection. However, a 2 column by 3 row source selection that starts with the CATEGORY INFORMATION row can only be pasted into a 2 column by 3 row destination selection that also starts with the CATEGORY INFORMATION row.
   e. If you attempt to paste a multiple-cell selection into an incompatible destination selection, you will receive a descriptive error message that explains why you will be unable to paste the selection. Information that describes the dimensions of both the source and destination multiple-cell selections will appear.

5. A copied or cut multiple-cell selection can be pasted into a compatible multiple-cell destination.
   a. The multiple-cell destination must meet the same constraints as described in 4d. above.
   b. All cells in the multiple-cell destination must actually exist within the destination template. For example, a 3 column by 4 row source selection could not be pasted into a multiple-cell destination defined by a single selected cell in the Category 5 column because there would be no room for the right-most column of the source selection.

Selection Memory

The most recent single- or multiple-cell selection for each of the Single Jeopardy! and Double Jeopardy! rounds within each game is saved both within a single Classroom Jeopardy! Clue Studio session and across multiple Classroom Jeopardy! Clue Studio sessions. For example, if you have all of Category 3 selected for the Single Jeopardy! view for Game A when you close the game, you will see the same selection if you reopen the same game later in the session. Similarly, as long as the Game A .html file remains in the same location, you will see the same selection if you reopen the same game during a later Classroom Jeopardy! Clue Studio session.
Shortcut Commands

As previously mentioned, Classroom Jeopardy! Clue Studio incorporates many of the same keyboard shortcuts that are used in other programs. Remember that the Control key on Windows®-based PCs is typically labeled CTRL. Macintosh users should use the COMMAND key instead of the CONTROL key in keystroke combinations.

- CONTROL + N opens a blank template for creating a new game.
- CONTROL + O opens an existing game.
- CONTROL + S lets you save the game you have just created.
- CONTROL + C copies selected text onto the clipboard.
- CONTROL + X deletes selected text from a game and copies it onto the clipboard.
- CONTROL + V pastes text from the clipboard into a selected location in a game.
- CONTROL + Z reverses the most recently performed action.
- CONTROL + Y restores the most recently undone action.
- CONTROL + A highlights an entire game template for copying or cutting.

THE SPELL CHECKER

Spell Checker Feature

Classroom Jeopardy! Clue Studio lets you spell check your game to ensure that the content in your templates and game USB Flash Drive is accurately entered.

Entire Game Spell Checking

To run the Spell Checker on the entire game, select TOOLS → SPELL CHECKER from the menu bar. This will spell check the contents of all cells in the game in the following order:

1. Game Name
2. Single Jeopardy! Round
3. Double Jeopardy! Round
4. Final Jeopardy! Round

Once the spell check starts, the template view will be set to Single Jeopardy!. Upon reaching Step 3, the template view will be set to Double Jeopardy! and the spell check will continue. Upon completion, the template view will be reset to its initial state.

While spell checking the entire game, a progress bar will be displayed in the STATUS BAR at the bottom of the screen. It will show how much of the operation has been completed. As long as no potential spelling errors are detected, the user will see the operation proceed steadily toward completion. If a potential spelling error is detected, the Spell Checker SUGGESTIONS window will pop-up to allow the user to correct or override the Spell Checker.
Interactive Spell Checker Operation

When the Spell Checker detects a potential spelling error, it will pop-up the SUGGESTIONS window.

In this situation, the cell location where the potential error was detected is shown as part of the title. The normal game template will be visible behind the pop-up window and will be synchronized with the spell check operation to show the Single or Double Jeopardy! template being checked. If necessary, you can click and drag on the title bar and move the pop-up window to view the underlying cells of the template.

The following fields and buttons are displayed in the Spell Checker window and may display data, depending on the situation:

- **NOT IN DICTIONARY** field: The NOT IN DICTIONARY field indicates that a misspelled word was detected. The word is considered misspelled because it could not be located in any open dictionaries. Edit the word in this box or select a suggestion from the list, then click the CHANGE button to correct the word, or press the IGNORE button to skip the word.

- **SUGGESTIONS** field: The SUGGESTIONS field contains a list of suggested replacements for the word reported as misspelled. Repeated clicks on the SUGGEST button may yield more suggestions. If the word in the NOT IN DICTIONARY field has not been edited, the word selected in the SUGGESTIONS field will be used as the replacement when either the CHANGE or CHANGE ALL button is pressed.

- **CHANGE** button: Click the CHANGE button to cause the reported word to be replaced. If the problem word was edited, the edited word is used as the replacement. Otherwise, the selected suggestion is used as the replacement. Only this occurrence of the reported word is replaced. If you want this and all following occurrences of the word replaced, select the CHANGE ALL button.

- **CHANGE ALL** button: Click the CHANGE ALL button to cause this and all following occurrences of the reported word to be replaced. If the problem word was edited, the edited word will be used as the replacement. Otherwise, the selected suggestion will be used as the replacement. If you want only this occurrence of the word to be replaced, use the CHANGE button.

- **IGNORE** button: Click the IGNORE button to cause the occurrence of a misspelled word to be skipped. If the same misspelled word appears later, it will be reported again.

- **IGNORE ALL** button: Click the IGNORE ALL button to cause this and all further occurrences of a misspelled word to be skipped. You might use this button if the word reported as a misspelling is actually spelled correctly. If the word is one you use frequently, you may wish to ignore it permanently by selecting the ADD button.

- **SUGGEST** button: Click the SUGGEST button to cause the Spell Checker to search more thoroughly for suggested replacements for the current misspelled word. Each time you press the SUGGEST button, a deeper search is made. The SUGGEST button is disabled once all possible suggestions have been located.

- **ADD** button: Click the ADD button to cause the reported word to be added to the user’s dictionary. Click the ADD button if a correctly spelled word you use often is reported as a misspelling. If the word is not used frequently, you may want to select the IGNORE or IGNORE ALL buttons instead.

- **CANCEL** button: The CANCEL button stops the current spelling check.

- **UNDO EDIT** button: Click the UNDO EDIT button to remove any changes made to the text in the NOT IN DICTIONARY field. The NOT IN DICTIONARY button appears in place of the IGNORE button only if the text in the NOT IN DICTIONARY field has been changed.

Classroom Jeopardy Online

Here are some of the ways you and other teachers can share games:

- Create games that can be placed on a server for individual schools to download.
- Store games and their assets files on a server for district-wide use among teachers.
- E-mail one or more games and their assets files by enclosing them as attachments.
- Upload and download games from the Internet. Visit Classroom Jeopardy! Online (www.ClassroomJeopardy.com) and find hundreds of games for FREE!
Classroom Jeopardy! Online has Jeopardy! games created by teachers for their own classrooms. Games are organized by subject and grade level. You can download games to play as is, or modify them to customize the content to your curriculum. You can also share your games with other teachers by uploading them to www.ClassroomJeopardy.com.

### IDEAS FOR CATEGORIES AND CLUES

The flexibility provided by Classroom Jeopardy! Clue Studio means the game possibilities are limitless. Here are some category and clue ideas to get you started. The categories are grouped roughly by subject matter, but remember you can create games and categories that cover more than one subject.

#### Classroom Rules and Procedures Games

It takes a bit of effort to create a game based on your own classroom procedures, but you can use it year after year, modifying the game if necessary.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety First</td>
<td>• THE PLACE WE MEET IF THERE’S A FIRE ALARM DURING RECESS</td>
</tr>
<tr>
<td></td>
<td>• A PLACE WHERE WE ARE ALLOWED TO RUN</td>
</tr>
<tr>
<td>Our Day</td>
<td>• THE FIRST THING WE DO WHEN WE COME INTO THE CLASSROOM EVERY MORNING</td>
</tr>
<tr>
<td></td>
<td>• THE SUBJECT WE STUDY RIGHT AFTER LUNCH</td>
</tr>
<tr>
<td>Out and About</td>
<td>• THE DAY OF THE WEEK OUR CLASS VISITS THE SCHOOL LIBRARY</td>
</tr>
<tr>
<td></td>
<td>• WHERE WE’RE GOING ON OUR NEXT FIELD TRIP</td>
</tr>
<tr>
<td>Best Behavior</td>
<td>• HOW WE EARN A STICKER FOR THE DAY</td>
</tr>
<tr>
<td></td>
<td>• WHAT WE BRING TO SCHOOL AFTER AN ABSENCE</td>
</tr>
</tbody>
</table>

#### Get Acquainted Games

Pass out a questionnaire to gather the information for a beginning-of-the-year game to help students get to know one another. Then write a game based on their responses.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Fun</td>
<td>• SHE’S A STUDENT WHO HAS FOUR BROTHERS.</td>
</tr>
<tr>
<td></td>
<td>• HIS MOTHER WORKS AT OUR SCHOOL.</td>
</tr>
<tr>
<td>Hobbies</td>
<td>• SHE’S A STUDENT WHO IS A GIRL SCOUT.</td>
</tr>
<tr>
<td></td>
<td>• HE’S A STUDENT WHO COLLECTS BASEBALL CARDS.</td>
</tr>
<tr>
<td>Fun Facts</td>
<td>• SHE WON BEST COSTUME AT LAST YEAR’S HALLOWEEN CARNIVAL.</td>
</tr>
<tr>
<td></td>
<td>• SHE’S A STUDENT WHO HAS AN IGUANA FOR A PET.</td>
</tr>
<tr>
<td>Talented Kids</td>
<td>• SHE’S A STUDENT WHO PLAYS THE FLUTE.</td>
</tr>
<tr>
<td></td>
<td>• HE’S A STUDENT WHO SPEAKS KOREAN.</td>
</tr>
<tr>
<td>Facts and Figures</td>
<td>• HE WAS BORN IN ALBERTA, CANADA.</td>
</tr>
<tr>
<td></td>
<td>• HE’S A STUDENT WHOSE MIDDLE NAME IS ANDREW.</td>
</tr>
<tr>
<td>Sporty Students</td>
<td>• SHE PLAYS THIRD BASE ON A SOFTBALL TEAM.</td>
</tr>
<tr>
<td></td>
<td>• HE’S A STUDENT WHO RIDES A SKATEBOARD TO SCHOOL.</td>
</tr>
</tbody>
</table>
**Spelling and Grammar Games**

<table>
<thead>
<tr>
<th>Categories</th>
<th>Sample Clues</th>
<th>Correct Responses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homophone Pairs</td>
<td>• AN INSECT AND YOUR MOTHER’S SISTER</td>
<td>• WHAT ARE ANT AND AUNT?</td>
</tr>
<tr>
<td></td>
<td>• A MAN AND LETTERS OR POSTCARDS</td>
<td>• WHAT ARE MALE AND MAIL?</td>
</tr>
<tr>
<td>Homograph Pairs</td>
<td>• A NOTE TO A FRIEND OR A PART OF THE ALPHABET</td>
<td>• WHAT IS A LETTER?</td>
</tr>
<tr>
<td></td>
<td>• A TOY THAT SPINS AND THE HIGHEST POINT</td>
<td>• WHAT IS A TOP?</td>
</tr>
<tr>
<td>Shun, Shun, Shun</td>
<td>• THE CORRECT SPELLING FOR A WORD THAT MEANS “MOVEMENT”</td>
<td>• WHAT IS M-O-T-I-O-N?</td>
</tr>
<tr>
<td></td>
<td>• THE CORRECT SPELLING FOR A WORD THAT MEANS “SEA”</td>
<td>• WHAT IS O-C-E-A-N?</td>
</tr>
<tr>
<td></td>
<td>• THE CORRECT SPELLING FOR A WORD THAT MEANS “SOMETHING YOU OWN”</td>
<td>• WHAT IS P-O-S-S-E-S-S-I-O-N?</td>
</tr>
<tr>
<td>The Long Way</td>
<td>• AD</td>
<td>• WHAT IS ADVERTISEMENT?</td>
</tr>
<tr>
<td></td>
<td>• BIKE</td>
<td>• WHAT IS BICYCLE?</td>
</tr>
<tr>
<td>Plurals</td>
<td>• TOOTH</td>
<td>• WHAT IS T-E-E-T-H?</td>
</tr>
<tr>
<td></td>
<td>• SPY</td>
<td>• WHAT IS S-P-I-E-S?</td>
</tr>
<tr>
<td>Parts of Speech</td>
<td>• IT’S THE ADVERB IN THIS SENTENCE: ANN RAN QUICKLY.</td>
<td>• WHAT IS QUICKLY?</td>
</tr>
<tr>
<td></td>
<td>• PREPOSITION OR ADVERB? THE WORD “ON” IN THE SENTENCE “ROVER IS ON THE PORCH.”</td>
<td>• WHAT IS A PREPOSITION?</td>
</tr>
<tr>
<td></td>
<td>• COMMON OR PROPER NOUN? CHICAGO*</td>
<td>• WHAT IS A PROPER NOUN?</td>
</tr>
<tr>
<td>Great Grammar</td>
<td>• THE SUBJECT IN THE SENTENCE “I BROUGHT HOME A PUPPY.”</td>
<td>• WHAT IS I?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE PAST TENSE OF “BRING.”</td>
<td>• WHAT IS BROUGHT?</td>
</tr>
</tbody>
</table>

*Clues like this with only two possible responses should be “Single Play.”
**Phonics Games**

Even students with limited reading skills can enjoy Classroom Jeopardy! games because the host reads clues aloud.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E Sounds All Around</strong></td>
<td>• IT’S ANY WORD THAT HAS THE SHORT “E” SOUND.</td>
<td>• MANY POSSIBLE RESPONSES. EXAMPLE: WHAT IS PEN? OR WHAT IS SHED?</td>
</tr>
<tr>
<td></td>
<td>• HE’S A STUDENT IN THIS CLASS WHOSE NAME HAS THE SHORT “E” SOUND.</td>
<td>• MANY POSSIBLE RESPONSES. EXAMPLE: WHO IS BEN? OR WHO IS FRED?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A COLOR THAT HAS THE LONG “E” SOUND.</td>
<td>• SEVERAL POSSIBLE RESPONSES. EXAMPLE: WHAT IS GREEN? OR WHAT IS PEACH?</td>
</tr>
<tr>
<td><strong>Starting Sounds</strong></td>
<td>• IT’S AN ANIMAL THAT BEGINS WITH THE SAME LETTER AS THE WORD “MOTHER.”</td>
<td>• SEVERAL POSSIBLE RESPONSES. EXAMPLE: WHAT IS A MONKEY? OR WHAT IS A MOOSE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A WORD THAT STARTS WITH THE LETTER “R” AND RHYMES WITH SING.</td>
<td>• WHAT IS RING?</td>
</tr>
<tr>
<td><strong>Wonderful W</strong></td>
<td>Correct responses begin with the letter “w.”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S A THREE-LETTER WORD.</td>
<td>• MANY POSSIBLE RESPONSES. EXAMPLE: WHAT IS WIN? WHAT IS WIG?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A WORD THAT RHYMES WITH “REST.”</td>
<td>• WHAT IS WEST?</td>
</tr>
<tr>
<td><strong>A, E, I, O, U</strong></td>
<td>• IT IS THE VOWEL SOUND IN THE WORD “CAT.”</td>
<td>• WHAT IS SHORT A?</td>
</tr>
<tr>
<td></td>
<td>• THEY ARE THE TWO VOWEL SOUNDS IN THE WORD “SILLY.”</td>
<td>• WHAT ARE SHORT I AND LONG E?</td>
</tr>
<tr>
<td><strong>The End</strong></td>
<td>• IT’S THE ENDING SOUND IN THIS WORD: (PICTURE OF A HAT)</td>
<td>• WHAT IS /T/?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A WORD THAT HAS THE SAME ENDING SOUND AS “BIKE.”</td>
<td>• MANY POSSIBLE RESPONSES. EXAMPLE: WHAT IS ROCK? OR WHAT IS LAKE?</td>
</tr>
<tr>
<td><strong>Word Rhymes</strong></td>
<td>• IT’S A WORD THAT BEGINS WITH THE LETTER “R” AND RHYMES WITH “SUN.”</td>
<td>• WHAT IS RUN?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A WORD THAT RHYMES WITH “SAD” AND MEANS “FATHER.”</td>
<td>• WHAT IS DAD?</td>
</tr>
<tr>
<td><strong>er, ir, or</strong></td>
<td>Name the word and the missing letters—“er,” “ir,” “or.”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THIS IS A ROUND SHAPE: C _ _ CLE</td>
<td>• WHAT IS CIRCLE - IR?</td>
</tr>
<tr>
<td></td>
<td>• THIS IS A YELLOW VEGETABLE: C _ _ N</td>
<td>• WHAT IS CORN - OR?</td>
</tr>
<tr>
<td><strong>Silent E Pairs</strong></td>
<td>The correct response is two words that are spelled the same except one ends in silent “e.”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S A CONTAINER FOR SODA AND A STICK TO HELP YOU WALK.</td>
<td>• WHAT ARE CAN AND CANE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S NOT VERY BRIGHT AND IT’S A TEN-CENT PIECE.</td>
<td>• WHAT ARE DIM AND DIME?</td>
</tr>
</tbody>
</table>
Vocabulary Games

The Jeopardy! format lends itself well to vocabulary review. You might devote entire games to words introduced in your language arts or foreign language curriculum or use “Vocabulary” as a category in other games.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ants and Syns</td>
<td>• THEY’RE TWO SYNONYMS FOR BIG.</td>
<td>• SEVERAL POSSIBLE RESPONSES. EXAMPLE: WHAT ARE LARGE AND HUGE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S AN ANTONYM FOR FORGET.</td>
<td>• MULTIPLE POSSIBLE RESPONSES. EXAMPLE: WHAT IS REMEMBER? OR WHAT IS RECALL?</td>
</tr>
<tr>
<td>Rhyme Time</td>
<td>The correct response is two words that rhyme and fit the clue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S A BEAUTIFUL TOWN.</td>
<td>• WHAT IS A PRETTY CITY?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A RABBIT THAT TELLS GOOD JOKES.</td>
<td>• WHAT IS A FUNNY BUNNY?</td>
</tr>
<tr>
<td>Analogies</td>
<td>• PUPPY IS TO DOG AS KITTEN IS TO THIS.</td>
<td>• WHAT IS CAT?</td>
</tr>
<tr>
<td></td>
<td>• APPLE IS TO FRUIT AS SQUASH IS TO THIS.</td>
<td>• WHAT IS VEGETABLE?</td>
</tr>
<tr>
<td>Groovy Groupings</td>
<td>The correct response is the name for a group of the things in the clue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• BIRDS, SHEEP, OR CHURCH-GOERS</td>
<td>• WHAT IS A FLOCK?</td>
</tr>
<tr>
<td></td>
<td>• MUSICIANS OR THIEVES</td>
<td>• WHAT IS A BAND?</td>
</tr>
<tr>
<td>Let’s Speak Spanish</td>
<td>• CAT</td>
<td>• WHAT IS GATO?</td>
</tr>
<tr>
<td></td>
<td>• 5</td>
<td>• WHAT IS CINCO?</td>
</tr>
</tbody>
</table>
# High School Reading Games

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Character</td>
<td>• “THE CATCHER IN THE RYE”</td>
<td>• WHO IS HOLDEN CAULFIELD?</td>
</tr>
<tr>
<td></td>
<td>• “THE SCARLET LETTER”</td>
<td>• WHO IS HESTER PRYNNE?</td>
</tr>
<tr>
<td>Finn’s In</td>
<td>• HE’S THE AUTHOR OF “THE ADVENTURES OF HUCKLEBERRY FINN.”</td>
<td>• WHO IS MARK TWAIN? OR WHO IS SAMUEL CLEMENS?</td>
</tr>
<tr>
<td></td>
<td>• HE’S HUCK FINN’S BEST FRIEND.</td>
<td>• WHO IS TOM SAWYER?</td>
</tr>
<tr>
<td></td>
<td>• HUCK AND JIM TRAVELED ON THIS BODY OF WATER.</td>
<td>• WHAT IS THE MISSISSIPPI RIVER?</td>
</tr>
<tr>
<td></td>
<td>• TWO WORDS THAT DESCRIBE THE MAIN CHARACTER IN “THE ADVENTURES OF HUCKLEBERRY FINN.”</td>
<td>• MULTIPLE POSSIBLE RESPONSES. EXAMPLE: WHAT ARE RESOURCEFUL AND MISCHIEVOUS?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A THEME IN THE NOVEL “THE ADVENTURES OF HUCKLEBERRY FINN.”</td>
<td>• MULTIPLE POSSIBLE RESPONSES. EXAMPLES: WHAT IS PERSONAL FREEDOM? OR WHAT WERE THE EFFECTS OF SLAVERY ON WHITE AND BLACK AMERICANS?</td>
</tr>
<tr>
<td>Lit Language</td>
<td>• IT’S AN EXAMPLE OF A WORK WRITTEN IN THE THIRD PERSON.</td>
<td>• MULTIPLE POSSIBLE RESPONSES.</td>
</tr>
<tr>
<td>Comedy or Tragedy?</td>
<td>• “A MIDSUMMER NIGHT’S DREAM”**</td>
<td>• WHAT IS A COMEDY?</td>
</tr>
<tr>
<td></td>
<td>• “HAMLET”**</td>
<td>• WHAT IS A TRAGEDY?</td>
</tr>
<tr>
<td>Complete the Quote</td>
<td>• IT’S FROM “THE GRAPES OF WRATH”: “WHEREVER THEY’RE A FIGHT SO HUNGRY PEOPLE CAN EAT, ___ ___ ___.”</td>
<td>• WHAT IS “I’LL BE THERE”?</td>
</tr>
<tr>
<td>Who Said It?</td>
<td>• “OUT, DAMNED SPOT! OUT, I SAY!”</td>
<td>• WHO IS LADY MACBETH?</td>
</tr>
</tbody>
</table>

*Clues like this with only two possible responses should be “Single Play.”*
**Arithmetic Facts Games**

Arithmetic facts games can include different mathematical operations or concentrate on only one. They can express problems in a variety of ways.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Super Sums</strong></td>
<td>• IT’S THE SUM OF 8 AND 3.</td>
<td>• WHAT IS 11?</td>
</tr>
<tr>
<td></td>
<td>• IT’S AN ADDITION PROBLEM THAT HAS THE SAME SUM AS 14 + 4.</td>
<td>• MULTIPLE RESPONSES POSSIBLE.EXAMPLE: WHAT IS 9 + 9? OR WHAT IS 10 + 8?</td>
</tr>
<tr>
<td><strong>Add It Up</strong></td>
<td>• 6 + 1 + 4 + 10</td>
<td>• WHAT IS 21?</td>
</tr>
<tr>
<td></td>
<td>• 4 ½ + 2 ½</td>
<td>• WHAT IS 7?</td>
</tr>
<tr>
<td><strong>Divide and Conquer</strong></td>
<td>• IT’S A DIVISION PROBLEM THAT EQUALS 7.</td>
<td>• MULTIPLE RESPONSES POSSIBLE. EXAMPLE: WHAT IS 28 ÷ 4? OR WHAT IS 49 ÷ 7?</td>
</tr>
<tr>
<td></td>
<td>• 144 ÷ 12</td>
<td>• WHAT IS 12?</td>
</tr>
<tr>
<td><strong>Operation Overload</strong></td>
<td>• 2 x 4 + 8 – 3</td>
<td>• WHAT IS 13?</td>
</tr>
<tr>
<td></td>
<td>• 6 + 2(6 ÷ 3)</td>
<td>• WHAT IS 10?</td>
</tr>
<tr>
<td><strong>Let’s Subtract</strong></td>
<td>• IT’S THE DIFFERENCE BETWEEN 12 AND 7.</td>
<td>• WHAT IS 5?</td>
</tr>
<tr>
<td></td>
<td>• IT’S WHAT YOU SUBTRACT FROM 16 TO GET 9.</td>
<td>• WHAT IS 7?</td>
</tr>
<tr>
<td><strong>Multiplication Marvels</strong></td>
<td>• 2 x 3 x 4</td>
<td>• WHAT IS 24?</td>
</tr>
<tr>
<td></td>
<td>• 4.5 x 100</td>
<td>• WHAT IS 450?</td>
</tr>
</tbody>
</table>
### Elementary Math Concepts Games

Don’t limit your Classroom Jeopardy! math games to drill and practice of arithmetic facts—the game works just as well to review other math concepts and skills.

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Comes Next?</td>
<td>• 3, 6, 9, 12, __</td>
<td>• WHAT IS 15?</td>
</tr>
<tr>
<td></td>
<td>The correct response is the item that comes next in the pattern.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• RED, YELLOW, BLUE, RED, YELLOW, __</td>
<td>• WHAT IS BLUE?</td>
</tr>
<tr>
<td>Round Offs</td>
<td>• IT’S 58 ROUNDED TO THE NEAREST HUNDRED.</td>
<td>• WHAT IS 100?</td>
</tr>
<tr>
<td></td>
<td>• IT’S 117 ROUNDED TO THE NEAREST TEN.</td>
<td>• WHAT IS 120?</td>
</tr>
<tr>
<td>In Betweenes</td>
<td>• IT’S A NUMBER BETWEEN 29 AND 31.</td>
<td>• WHAT IS 30?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A FRACTION BETWEEN (\frac{1}{2}) AND (\frac{3}{4}).</td>
<td>• MULTIPLE RESPONSES POSSIBLE. EXAMPLES: WHAT IS (\frac{3}{4})? OR WHAT IS (\frac{5}{8})?</td>
</tr>
<tr>
<td>What’s the Problem?</td>
<td>• JEREMY HAD 4 APPLES AND PICKED 7 MORE. HOW MANY DID HE HAVE IN ALL?</td>
<td>• WHAT IS 4 + 7?</td>
</tr>
<tr>
<td></td>
<td>• IF CLARE IS 9, HOW OLD WAS SHE 3 YEARS AGO?</td>
<td>• WHAT IS 9 – 3?</td>
</tr>
<tr>
<td>The Missing Link</td>
<td>• ANNA BOUGHT 4 PENCILS. HOW MUCH MONEY DID SHE SPEND?</td>
<td>• WHAT IS THE PRICE OF EACH PENCIL?</td>
</tr>
<tr>
<td></td>
<td>• IF CARLOS DROVE TO ANITA’S HOUSE AT 32 MILES PER HOUR, HOW LONG DID IT TAKE HIM TO GET THERE?</td>
<td>• WHAT IS THE DISTANCE TO ANITA’S HOUSE?</td>
</tr>
<tr>
<td>Greater Than and Less Than</td>
<td>• IT’S A NUMBER GREATER THAN 12 AND LESS THAN 14.</td>
<td>• WHAT IS 13?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A NUMBER GREATER THAN 45 AND LESS THAN 100.</td>
<td>• MULTIPLE RESPONSES POSSIBLE. EXAMPLE: WHAT IS 50?</td>
</tr>
<tr>
<td>Mighty Measurements</td>
<td>• IT’S THE NUMBER OF OUNCES IN ONE CUP.</td>
<td>• WHAT IS 8?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE NUMBER OF KILOMETERS IN A MILE.</td>
<td>• WHAT IS 1.6?</td>
</tr>
<tr>
<td>Place Value Challenge</td>
<td>• IT’S THE NUMERAL IN THE TENS PLACE IN 461.</td>
<td>• WHAT IS 6?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE NUMERAL IN THE HUNDREDTHS PLACE IN 816.15.</td>
<td>• WHAT IS 5?</td>
</tr>
</tbody>
</table>
### Elementary Math Concepts Games (continued)

<table>
<thead>
<tr>
<th>Categories</th>
<th>Sample Clues</th>
<th>Correct Responses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lowest Common Denominator</strong></td>
<td>• ½, ⅓</td>
<td>• WHAT IS 8?</td>
</tr>
<tr>
<td></td>
<td>• ⅔, ⅔, ⅔</td>
<td>• WHAT IS 24?</td>
</tr>
<tr>
<td></td>
<td>The correct response is the lowest common denominator for the fractions in the clue.</td>
<td></td>
</tr>
</tbody>
</table>

**Units of Time**

- IT’S THE NUMBER OF SECONDS IN A MINUTE. • WHAT IS 60?
- IT’S THE NUMBER OF HOURS IN A DAY. • WHAT IS 24?
- IT’S THE NUMBER OF SECONDS IN AN HOUR. • WHAT IS 3,600?

**Read the Clock**

- THE SHORT HAND IS ON 4 AND THE LONG HAND IS ON 12. • WHAT IS 4:00?
- THE HOUR HAND IS BETWEEN 8 AND 9 AND THE MINUTE HAND IS ON 3. • WHAT IS 8:15?

**AM or PM**

- 6:00 IN THE EVENING • WHAT IS PM?
- 3:00 IN THE MORNING • WHAT IS AM?
- THE CLOCK SAYS 1:00 AND THE SUN IS OUT. • WHAT IS PM?

**Time Goes By**

- NOON TO MIDNIGHT • WHAT IS 12 HOURS?
- 11:00 AM TO 2:00 PM • WHAT IS 3 HOURS?
- 4:00 AM TO 10:30 AM • WHAT IS 6½ HOURS?

**Say It Again**

- HALF PAST THREE • WHAT IS THREE THIRTY?
- QUARTER TO EIGHT • WHAT IS SEVEN FORTY-FIVE? OR WHAT IS FIFTEEN MINUTES TO EIGHT?

**Our Day**

- IT’S THE TIME WE START SCHOOL. • RESPONSES WILL VARY.
- IT’S THE TIME SHOWN ON OUR CLASSROOM CLOCK RIGHT NOW. • RESPONSES WILL VARY.

---

* You’ll probably find it helpful to use a teaching clock or images to illustrate the category “Read the Clock.”
## Geometry and Algebra Games

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magic Formulas</td>
<td>• IT’S THE FORMULA FOR FINDING THE CIRCUMFERENCE OF A CIRCLE.</td>
<td>• WHAT IS 2πr?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notable Numbers</td>
<td>• IT’S THE NUMBER OF DEGREES IN A CIRCLE.</td>
<td>• WHAT IS 360?</td>
</tr>
<tr>
<td></td>
<td>• THIS SPECIAL SYMBOL REPRESENTS THE RATIO OF A CIRCLE’S CIRCUMFERENCE TO ITS DIAMETER; IT EQUALS 3.142.</td>
<td>• WHAT IS PI?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polygons Profiles</td>
<td>• IT’S A THREE-SIDED POLYGON.</td>
<td>• WHAT IS A TRIANGLE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S AN EIGHT-SIDED POLYGON.</td>
<td>• WHAT IS AN OCTAGON?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>What’s Your Angle?</td>
<td>• IT’S THE SUM OF THE ANGLES OF A TRIANGLE.</td>
<td>• WHAT IS 180 DEGREES?</td>
</tr>
<tr>
<td></td>
<td>• IT’S AN ANGLE OF LESS THAN 90 DEGREES: ACUTE OR OBTUSE?*</td>
<td>• WHAT IS AN ACUTE ANGLE?</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hot Properties</td>
<td>• ACCORDING TO THE COMMUTATIVE PROPERTY, A + B = _______.</td>
<td>• WHAT IS B + A?</td>
</tr>
<tr>
<td></td>
<td>• THE NAME OF THIS PROPERTY: A (B + C) = AB + AC</td>
<td>• WHAT IS THE DISTRIBUTIVE PROPERTY?</td>
</tr>
</tbody>
</table>

*Clues like this with only two possible responses should be “Single Play.”
### Geography Games

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Where Are We?</strong></td>
<td>• IT’S THE STATE WE LIVE IN.</td>
<td>• RESPONSES WILL VARY.</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE OCEAN NEAREST TO WHERE WE LIVE.</td>
<td>• RESPONSES WILL VARY.</td>
</tr>
<tr>
<td><strong>America the Beautiful</strong></td>
<td>The correct response is a U.S. state.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S THE LARGEST STATE.</td>
<td>• WHAT IS ALASKA?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE STATE THAT IS FARthest SOUTH.</td>
<td>• WHAT IS HAWAII?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE STATE YOSEMITE NATIONAL PARK IS IN.</td>
<td>• WHAT IS CALIFORNIA?</td>
</tr>
<tr>
<td></td>
<td>• ITS NICKNAME IS THE “GARDEN STATE.”</td>
<td>• WHAT IS NEW JERSEY?</td>
</tr>
<tr>
<td><strong>“New” Places</strong></td>
<td>The correct response includes the word “new.”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S A U.S. STATE.</td>
<td>• ANSWERS WILL VARY. EXAMPLES: WHAT IS NEW JERSEY? OR WHAT IS NEW HAMPSHIRE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE CITY WITH THE HIGHEST POPULATION IN THE U.S.</td>
<td>• WHAT IS NEW YORK, NEW YORK?</td>
</tr>
<tr>
<td></td>
<td>• THERE IS A BREED OF DOG NAMED AFTER THIS CANADIAN PROVINCE.</td>
<td>• WHAT IS NEWFOUNDLAND?</td>
</tr>
<tr>
<td><strong>Going to Extremes</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S THE LONGEST RIVER IN THE WORLD.</td>
<td>• WHAT IS THE NILE?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE COUNTRY WITH THE HIGHEST POPULATION IN THE WORLD.</td>
<td>• WHAT IS CHINA?</td>
</tr>
<tr>
<td><strong>Capital Capers</strong></td>
<td>The correct response is a capital city.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IT’S THE CAPITAL OF CALIFORNIA.</td>
<td>• WHAT IS SACRAMENTO?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE CAPITAL OF THE LARGEST COUNTRY IN THE WORLD.</td>
<td>• WHAT IS MOSCOW?</td>
</tr>
<tr>
<td><strong>Border Patrol</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THEY’RE THE TWO COUNTRIES THAT BORDER THE UNITED STATES.</td>
<td>• WHAT ARE MEXICO AND CANADA?</td>
</tr>
<tr>
<td></td>
<td>• IT FORMS THE BORDER BETWEEN ARKANSAS AND MISSISSIPPI.</td>
<td>• WHAT IS THE MISSISSIPPI RIVER?</td>
</tr>
<tr>
<td><strong>Under the Surface</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THEY’RE CAUSED BY SHIFTS IN TECTONIC PLATES.</td>
<td>• WHAT ARE EARTHQUAKES?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A TERM THAT DESCRIBES HOW THE EARTH’S LAND MASSES ARE MOVING AWAY FROM EACH OTHER GRADUALLY.</td>
<td>• WHAT IS CONTINENTAL DRIFT?</td>
</tr>
</tbody>
</table>
### History Games

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firsts</strong></td>
<td>• HE’S THE FIRST U.S. PRESIDENT.</td>
<td>• WHO IS GEORGE WASHINGTON?</td>
</tr>
<tr>
<td></td>
<td>• HE WAS THE FIRST PERSON TO SET FOOT ON THE MOON.</td>
<td>• WHO IS NEIL ARMSTRONG?</td>
</tr>
<tr>
<td></td>
<td>• SHE WAS THE FIRST WOMAN APPOINTED TO THE U.S. SUPREME COURT.</td>
<td>• WHO IS SANDRA DAY O’CONNOR?</td>
</tr>
<tr>
<td><strong>Relatively Speaking</strong></td>
<td>• HE’S PRESIDENT GEORGE W. BUSH’S FATHER.</td>
<td>• WHO IS GEORGE BUSH?</td>
</tr>
<tr>
<td></td>
<td>• ONE OF SENATOR TED KENNEDY’S BROTHERS, HE WAS THE 35TH U.S. PRESIDENT.</td>
<td>• WHO IS JOHN F. KENNEDY?</td>
</tr>
<tr>
<td></td>
<td>• SHE WAS KNOWN AS “THE VIRGIN QUEEN,” AND WAS HENRY VIII’S DAUGHTER.</td>
<td>• WHO IS QUEEN ELIZABETH I?</td>
</tr>
<tr>
<td><strong>Decades</strong></td>
<td><strong>The correct response is the decade in which the event occurred.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THE U.S. ENTERED WORLD WAR II.</td>
<td>• WHAT IS THE 1940s?</td>
</tr>
<tr>
<td></td>
<td>• THE NINETEENTH AMENDMENT IS PASSED, GUARANTEEING WOMEN THE RIGHT TO VOTE.</td>
<td>• WHAT IS THE 1920s?</td>
</tr>
<tr>
<td><strong>First Things First</strong></td>
<td><strong>The correct response is the event that happened first.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THE AMERICAN REVOLUTION</td>
<td>• WHAT IS COLUMBUS’S VOYAGE TO NORTH AMERICA?</td>
</tr>
<tr>
<td></td>
<td>• COLUMBUS’S VOYAGE TO NORTH AMERICA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• BATTLE OF THE ALAMO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• U.S. CIVIL WAR</td>
<td>• WHAT IS THE REVOLUTIONARY WAR?</td>
</tr>
<tr>
<td></td>
<td>• THE CIVIL RIGHTS MOVEMENT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• THE REVOLUTIONARY WAR</td>
<td></td>
</tr>
<tr>
<td><strong>Amendments</strong></td>
<td>• IT GUARANTEES FREEDOM OF SPEECH.</td>
<td>• WHAT IS THE FIRST AMENDMENT?</td>
</tr>
<tr>
<td></td>
<td>• IT PROHIBITS STATES FROM DEPRIVING PEOPLE THE RIGHT TO VOTE BASED ON THEIR RACE.</td>
<td>• WHAT IS THE FIFTEENTH AMENDMENT?</td>
</tr>
<tr>
<td>CATEGORIES</td>
<td>SAMPLE CLUES</td>
<td>CORRECT RESPONSES</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Our Solar System</td>
<td>• IT’S THE THIRD PLANET FROM THE SUN.</td>
<td>• WHAT IS EARTH?</td>
</tr>
<tr>
<td></td>
<td>• THEY ARE PHOBOS AND DEIMOS.</td>
<td>• WHAT ARE MARS’ MOONS?</td>
</tr>
<tr>
<td>Weather Words</td>
<td>• IT’S A COMMON NAME FOR A TSUNAMI.</td>
<td>• WHAT IS A TIDAL WAVE?</td>
</tr>
<tr>
<td></td>
<td>• CIRRUS, NIMBUS, OR STRATUS ARE TYPES OF THEM.</td>
<td>• WHAT ARE CLOUDS?</td>
</tr>
<tr>
<td>Animal Records</td>
<td>• IT’S THE LARGEST ANIMAL ON EARTH.</td>
<td>• WHAT IS THE BLUE WHALE?</td>
</tr>
<tr>
<td></td>
<td>• MEASURING UP TO 18 FEET TALL, IT’S THE TALLEST LAND ANIMAL.</td>
<td>• WHAT IS A GIRAFFE?</td>
</tr>
<tr>
<td>In the Genes</td>
<td>• THIS CHEMICAL SUBSTANCE CONTAINS THE GENETIC INFORMATION FOR HUMANS AND MOST LIVING THINGS.</td>
<td>• WHAT IS DNA?</td>
</tr>
<tr>
<td></td>
<td>• BLUE EYES AND BLONDE HAIR—RECESSIVE OR DOMINANT TRAITS?*</td>
<td>• WHAT ARE RECESSIVE TRAITS?</td>
</tr>
<tr>
<td>Acid or Base?</td>
<td>• LEMON JUICE</td>
<td>• WHAT IS AN ACID?</td>
</tr>
<tr>
<td></td>
<td>• A SUBSTANCE WITH A PH OF MORE THAN 7</td>
<td>• WHAT IS A BASE?</td>
</tr>
<tr>
<td>In Terms of Science</td>
<td>• IT’S AN EXAMPLE OF ORGANISMS THAT HAVE A MUTUALISTIC RELATIONSHIP.</td>
<td>• SEVERAL POSSIBLE RESPONSES. EXAMPLE: WHAT ARE BEES AND FLOWERING PLANTS?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE PROCESS BY WHICH PLANTS TURN SUNLIGHT INTO FOOD ENERGY.</td>
<td>• WHAT IS PHOTOSYNTHESIS?</td>
</tr>
<tr>
<td>Have a Hundred</td>
<td>• IT’S A DOLLAR.</td>
<td>• WHAT IS 100 CENTS?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A CENTURY.</td>
<td>• WHAT IS 100 YEARS?</td>
</tr>
<tr>
<td></td>
<td>• IT HAS A PICTURE OF BENJAMIN FRANKLIN.</td>
<td>• WHAT IS THE 100-DOLLAR BILL?</td>
</tr>
<tr>
<td></td>
<td>• ONE AND TWO-THIRDS HOURS.</td>
<td>• WHAT IS 100 MINUTES?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE TEMPERATURE AT WHICH WATER BOILS.</td>
<td>• WHAT IS 100 DEGREES CELSIUS?</td>
</tr>
<tr>
<td>All-Time Greats</td>
<td>• SHE’S YOUR MOTHER’S MOTHER’S MOTHER.</td>
<td>• WHAT IS GREAT-GRANDMOTHER?</td>
</tr>
<tr>
<td></td>
<td>• THEY’RE LARGE BODIES OF FRESH WATER IN NORTHEASTERN NORTH AMERICA.</td>
<td>• WHAT ARE THE GREAT LAKES?</td>
</tr>
<tr>
<td></td>
<td>• IT’S THE SEQUEL TO “CHARLIE AND THE CHOCOLATE FACTORY.”</td>
<td>• WHAT IS “CHARLIE AND THE GREAT GLASS ELEVATOR”?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A MAN-MADE OBJECT ON EARTH THAT CAN BE SEEN FROM SPACE.</td>
<td>• WHAT IS THE GREAT WALL? OR WHAT IS THE GREAT WALL OF CHINA?</td>
</tr>
<tr>
<td></td>
<td>• IT’S A PERIOD OF U.S. ECONOMIC HARDSHIP IN THE 1930S.</td>
<td>• WHAT IS THE GREAT DEPRESSION?</td>
</tr>
<tr>
<td></td>
<td>• THE MAIN CHARACTER IN THIS NOVEL BY CHARLES DICKENS GOES FROM RAGS TO RICHES.</td>
<td>• WHAT IS “GREAT EXPECTATIONS”?</td>
</tr>
</tbody>
</table>

*Clues like this with only two possible responses should be “Single Play.”
### Science and Health Games (continued)

<table>
<thead>
<tr>
<th>CATEGORIES</th>
<th>SAMPLE CLUES</th>
<th>CORRECT RESPONSES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Famous Franks</strong></td>
<td><a href="#">• THIS MONSTER WAS THE LITERARY INVENTION OF MARY SHELLEY.</a></td>
<td><a href="#">• WHO IS FRANKENSTEIN?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• THIS FOUNDING FATHER WROTE “POOR RICHARD’S ALMANAC” AND CONDUCTED EXPERIMENTS TO STUDY ELECTRICITY.</a></td>
<td><a href="#">• WHO IS BENJAMIN FRANKLIN?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT MEANS “HONESTLY” OR “DIRECTLY.”</a></td>
<td><a href="#">• WHAT IS FRANKLY?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• HER FAMOUS DIARY TOLD THE STORY OF A JEWISH FAMILY IN HIDING DURING THE HOLOCAUST.</a></td>
<td><a href="#">• WHO IS ANNE FRANK?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• A TYPE OF SAUSAGE WAS NAMED FOR THIS CITY IN GERMANY</a></td>
<td><a href="#">• WHAT IS FRANKFURT?</a></td>
</tr>
<tr>
<td><strong>Primary Colors</strong></td>
<td><a href="#">• IT’S THE LARGEST ANIMAL THAT EVER LIVED.</a></td>
<td><a href="#">• WHAT IS THE BLUE WHALE?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT’S WHERE YOU SHOULD GO TO SEE THE Geyser OLD FAITHFUL.</a></td>
<td><a href="#">• WHAT IS YELLOWSTONE NATIONAL PARK?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• THE SYMBOL OF THIS INTERNATIONAL RELIEF ORGANIZATION RESEMBLES THE FLAG OF SWITZERLAND.</a></td>
<td><a href="#">• WHAT IS THE RED CROSS?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• THE BANJO IS FEATURED PROMINENTLY IN THIS STYLE OF MUSIC.</a></td>
<td><a href="#">• WHAT IS BLUEGRASS?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT’S A HUGE STORM IN THE ATMOSPHERE OF THE PLANET JUPITER.</a></td>
<td><a href="#">• WHAT IS THE GREAT RED SPOT?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• THIS HISTORICALLY IMPORTANT AREA IS THE CENTER OF MOSCOW.</a></td>
<td><a href="#">• WHAT IS RED SQUARE?</a></td>
</tr>
<tr>
<td><strong>Shape Shifters</strong></td>
<td><a href="#">• IT’S A PLAZA IN A CITY OR TOWN.</a></td>
<td><a href="#">• WHAT IS A SQUARE?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT’S AN EDIBLE CONTAINER FOR ICE CREAM.</a></td>
<td><a href="#">• WHAT IS A CONE?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT’S A MUSICAL INSTRUMENT.</a></td>
<td><a href="#">• WHAT IS A TRIANGLE?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• YOU’D SEE THIS TYPE OF HISTORICAL MONUMENT IN EGYPT OR MEXICO.</a></td>
<td><a href="#">• WHAT IS A PYRAMID?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• IT’S A MILITARY HEADQUARTERS BUILDING IN ARLINGTON, VA.</a></td>
<td><a href="#">• WHAT IS THE PENTAGON?</a></td>
</tr>
<tr>
<td></td>
<td><a href="#">• A V-8 ENGINE HAS 8 OF THEM.</a></td>
<td><a href="#">• WHAT IS A CYLINDER?</a></td>
</tr>
</tbody>
</table>
Incorporate Other Media
Augment the written on-screen clue with an image, video, or recorded sound. Possible categories include Animal Sounds, Name That Tune, Artists and Their Work, Who Is It?, Reading Graphs and Charts, and Reading Maps. A few sample media and clues are listed here.

- Include a recording of a coyote to go with the clue “Nighttime howler.”
- Insert a picture of a painting to go with the clue “The artist who painted this.”
- Play an audio clip of “The Star Spangled Banner” to go with the clue “Our national anthem.”
- Include a graph to go with the clue “The percentage of students in our class who have cats.”
- Include pictures of triangles of different proportions to go with the clue “The kind of shape these are examples of.”
- Include a photograph of Winston Churchill to go with the clue “The name of this British leader.”

Add Some Action
Spice up your games with “action” categories that challenge students to do something. Whether they’re serious or silly, these tasks are a great way to engage kinesthetic learners. For these types of challenges, eliminate the time limit and the requirement that students respond in the form of a question.

- Sing the alphabet song.
- Point to your cervical vertebrae.
- Draw a parallelogram.
- Measure the height of your desk.
- Spell your name in sign language.
- Make the sound an elephant makes.
- Find Morocco on the globe.
- Show “23” with the unifix blocks.
- Balance a pencil on your nose.

Challenge Students to Use Higher Thinking Skills
If you plan to be the game host, you can include clues that require a creative response. Questions that are somewhat open ended can provide variety and substance without compromising the game’s fairness. For example, you might include the clues “A factor that contributed to the extinction of the dodo bird” or “A person who played an important role in the Civil Rights Movement.” You may even wish to require that students follow their “question” response with a brief explanation. Be sure to make your expectations clear before students begin playing.
Classroom Jeopardy! has been engineered to provide teachers with ease of operation and to allow opportunities for expansion. Below is a list of optional game accessories you can purchase to expand the program’s capabilities.

**Accessories List**

EI-8001 Classroom Jeopardy! Accessory Scoreboard (ASB)

Includes:
- Accessory Scoreboard Unit
- AC Power Adapter
- Signal Cable
- 3 Player Remotes (2 AAA batteries required for each remote not included)
- 3 Wager Paddles
- Dry-erase Marker
- Guide
- Carrying case

EI-8002 Classroom Jeopardy! Extra Team Remotes. Includes 12 Player Remotes

EI-8004 Classroom Jeopardy! USB Blank 512 MB Flash Drives 3-Pack

EI-8098 Replacement Classroom Jeopardy! Host Remote

EI-8099G Replacement Classroom Jeopardy! Green Player Remote

EI-8099Y Replacement Classroom Jeopardy! Yellow Player Remote

EI-8099B Replacement Classroom Jeopardy! Blue Player Remote

**Accessory Scoreboards**

Your Classroom Jeopardy! unit comes with a scoreboard that displays scores for three players or teams. To accommodate multiple players, you can purchase Accessory Scoreboards (ASBs). (The Accessory Scoreboard, however, is NOT a replacement for the Base Unit.) Each ASB displays three scores. You can add up to nine Accessory Scoreboards to the Base Unit to display a maximum of 30 scores. (See page 69 for instructions on setting up the Accessory Scoreboard.)
SETTING UP THE ACCESSORY SCOREBOARD

Each Accessory Scoreboard (ASB) enables you to display three additional scores in your game. You can add up to nine ASBs to the Base Unit for a maximum of 30 scores.

1. The back of each Accessory Scoreboard has a four-position switch. The switch is used to set the code from the Base Unit so that the Player Remotes can be assigned to the corresponding scoreboards.

   Set the ASB switch as follows:

<table>
<thead>
<tr>
<th>ASB</th>
<th>Player No.</th>
<th>Switch Positions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1–3*</td>
<td>OFF OFF OFF OFF</td>
</tr>
<tr>
<td>1</td>
<td>4–6</td>
<td>OFF OFF OFF ON</td>
</tr>
<tr>
<td>2</td>
<td>7–9</td>
<td>OFF OFF ON OFF</td>
</tr>
<tr>
<td>3</td>
<td>10–12</td>
<td>OFF ON OFF ON</td>
</tr>
<tr>
<td>4</td>
<td>13–15</td>
<td>OFF ON OFF OFF</td>
</tr>
<tr>
<td>5</td>
<td>16–18</td>
<td>OFF ON OFF ON</td>
</tr>
<tr>
<td>6</td>
<td>19–21</td>
<td>OFF ON ON ON</td>
</tr>
<tr>
<td>7</td>
<td>22–24</td>
<td>OFF ON ON ON</td>
</tr>
<tr>
<td>8</td>
<td>25–27</td>
<td>ON OFF OFF OFF</td>
</tr>
<tr>
<td>9</td>
<td>28–30</td>
<td>ON OFF OFF ON</td>
</tr>
</tbody>
</table>

   *Players 1-3 are default to the Base Unit.

2. Make sure your TV and the Base Unit are turned off. Place the ASB(s) on top of or beside the Base Unit.

3. Plug one end of the power adapter into the ASB and the other end into the wall socket.

4. Insert one end of the Signal Cable into the Base Unit port marked SIGNAL OUT. Insert the other end into the ASB port marked SIGNAL IN.

5. If you have more than one ASB, connect the scoreboards in a similar fashion. Daisy-chain the first ASB to the second ASB, then the second ASB to the third one, and so on.

6. Once all the connections have been completed, turn on the TV, Base Unit, and ASBs. The Base Unit and ASB LEDs will illuminate.
**Configuring Scoreboards**

Once you have connected your Accessory Scoreboard(s) to the Base Unit, you may want to check that you have positioned the switches correctly so that the score panels correspond to the appropriate player numbers. Generally, the Base Unit displays scores for Players 1, 2, 3, the first ASB displays scores for Players 4, 5, 6, the second for Players 7, 8, 9, and so on.

1. Access the **JEOPARDY! START MENU** before you have selected a game or after you have just selected one (see page 37).

   ![Jeopardy! Start Menu BEFORE selecting a game](image)

   ![Jeopardy! Start Menu AFTER selecting a game](image)

2. Use the arrow buttons to highlight **OTHER OPTIONS**. Press **SELECT**.

3. The **JEOPARDY! OPTIONS MENU** will appear. Press **SELECT**.

4. The screen will display 10 groupings of numbers. These groupings indicate the different ways that the scoreboards can be configured. The numbers stand for the player numbers.

5. One or more groups of numbers will be highlighted. These numbers indicate the player numbers to which your scoreboards correspond. (Players 1, 2, and 3 are default to the Base Unit.) If you want to reconfigure your scoreboards, simply change the position of the switches located on the back of each Accessory Scoreboard. (See page 69 for information on setting the switch positions.)

6. Press **BEGIN** to return to the **JEOPARDY! OPTIONS MENU**.

7. Press **BEGIN** again to return to the **JEOPARDY! START MENU**.

   ![Configure Scoreboards](image)

   ![Available Players](image)

The highlighted numbers indicate that the scoreboards correspond to Players 1, 2, 3, and Players 4, 5, 6.
Programming Player Remotes

When you access the **JEOPARDY! OPTIONS MENU** before starting a game (see page 37), you can select the option **PROGRAM REMOTES**. This lets you assign or reassign numbers to the remotes. The three remotes that come with your Jeopardy! unit are already preprogrammed 1, 2, and 3, but you can change the numbers if you wish. Additional remotes you buy that are unprogrammed will need to be assigned a number.

1. Use the arrow buttons to highlight **PROGRAM REMOTES**. Press **SELECT**.

2. **PLAYER ?** will appear on screen. Press and hold the button on a Player Remote. The ? symbol will change to the current player number. (During each player number display, the corresponding score panel will show 88888 and the light above it will turn orange.)

3. After two seconds, the player number will revert back to the ? symbol. Continue holding down the Player Remote button for 30 seconds. The player number will reappear, indicating that the remote is now in programming mode. Release the button.

4. Press and release the Player Remote button quickly to increment the player number. The new number will appear on screen. (In programming mode, the number increments when the Player Remote button is released. If 30 is reached, the next number returns to 1.)

5. When the correct player number is displayed, press and hold the Player Remote button for four or five seconds until the player number disappears and then reappears. The new player number is now programmed into the remote. To check that the remote is operating correctly, press its button; the screen should show the programmed number.

6. If the Player Remote sits idle for more than two minutes in programming mode, the unit saves the last displayed player number and automatically exits programming mode. The saved player number does not appear on the screen when this occurs. At this point, check your remotes to make sure the numbers are what you want them to be.

7. To return to the **JEOPARDY! OPTIONS MENU**, press **BEGIN**.

8. Press **BEGIN** again to return to the **JEOPARDY! START MENU**.
Troubleshooting

Every effort has been made to make Classroom Jeopardy! a comprehensive, yet easy-to-use, program. If you experience a problem, read this section first for a possible solution. If you require additional help or information, please contact Customer Service.

Problem: The TV screen remains blank when Classroom Jeopardy! is started up.

Possible Solutions:

- Make sure that the TV and Classroom Jeopardy! Base Unit are turned on.
- Check that the TV has been set to VIDEO or LINE, corresponding to the audio/video connections between Classroom Jeopardy! and the TV.
- Some TV sets do not have a video/line button. Instead, they usually work by setting the channel to 3 or 4, depending on the geographical location. Use the channel selector button on the TV or your remote control to find the channel that accommodates the Classroom Jeopardy! game.
- Turn the Classroom Jeopardy! unit off and on.

Problem: The Base Unit has no power.

Possible Solutions:

- When you turn on the power switch on the base unit, the LEDs will illuminate. If they do not, check the power adapter connection to make sure the plug has been inserted securely.
- Check the wall socket connection and make sure there is power going into it.

Problem: A Player Remote does not work during a game nor does it register with the scoreboard.

Possible Solutions:

- Unscrew the door to the battery compartment. Check that the batteries have been inserted correctly.
- Replace the batteries with fresh ones.
- Check that Player Remotes have been assigned player numbers 1, 2, 3 for the base unit, 4, 5, 6 for the first accessory scoreboard, and so on.
- Check that the player remote has not been reprogrammed with a different player number. To do this, first access the JEOPARDY! OPTIONS MENU before starting a game and highlight the option PROGRAM REMOTES. Press SELECT on the Host Remote. Then press and hold the button on the Player Remote. The player number will appear briefly. If the number is incorrect, follow the steps in the section “Programming Player Remotes” to reprogram the remote with the correct number.

Problem: The Host Remote does not work during a game.

Possible Solutions:

- Unscrew the door to the battery compartment. Then check to see that the batteries have been placed in the correct positions.
- Replace the batteries with fresh ones.
- Make sure that players have registered their remotes.

Problem: During game programming, the TV screen is blank.

Possible Solutions:

- If the TV screen is black, check that the power is on.
- Check that the A/V cables are connected properly.

A player may inadvertently reprogram a remote by holding the signal button down for 30 seconds. To prevent this from happening, tell players that they must press and release their signal buttons quickly in order to keep the remotes from malfunctioning.
FCC INFORMATION

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Consult the dealer or an experienced radio/TV technician for help.

Note: The user is cautioned that changes and modifications made to the equipment without the approval of manufacturer could void the user’s authority to operate this equipment.

WARRANTY INFORMATION

Dear Customer,

Thank you for purchasing Classroom Jeopardy! We’re certain that you and your students will enjoy the learning fun offered by this product.

Educational Insights warrants each unit against factory defects in material and workmanship for one year from the date of purchase to the original purchaser only.

This warranty is invalid if the damage or defect is caused by accident, consumer abuse, or unauthorized alteration or repair.

This warranty does not cover any claim concerning worn-out or defective batteries.

If your Classroom Jeopardy! fails to operate satisfactorily during the first year after purchase, return it postage prepaid to the address below. Be sure to include the product, your name, address, phone number and/or e-mail, a copy of your sales receipt or invoice, and a brief description of the problem. If the unit is found to be defective within the first year, it will be repaired or replaced at no further cost to you.

Direct all returns to:

EDUCATIONAL INSIGHTS

Warranty Replacements
380 N. Fairway Drive
Vernon Hills, IL 60061

Customer Service:
(800) 995-4436 (U.S. & Canada) or
+44 (0)1553 762276 (U.K. & Europe)

Register your Classroom Jeopardy! unit at:
WWW.EDUCATIONALINSIGHTS.COM/PRODUCTREGISTRATION
EI-8000  NEW Classroom Jeopardy!  $499.99
EI-8001  Classroom Jeopardy! Extra Scoreboard  $349.99
EI-8002  Classroom Jeopardy! Extra Team Remotes (12 remotes)  $279.99
EI-8004  Classroom Jeopardy! USB Flash Drive 3-Pack  $49.99